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SECTION 1 Introduction to the Mapper

1.1 Overview of the Mapper

The Mapper is a visualisation and editing tool common to a number of CERC models,
which allows model features to be created, edited and displayed graphically. The
features you see in the Mapper vary depending on which model it is being used with;
for example, some are available across all models and some are specific to ADMS 6,
ADMS-Screen, ADMS-Urban, ADMS-Roads or ADMS-Airport.

The Mapper can be used to create, edit and display the following model features:

e Point, jet, line, area, volume and road sources,
e Buildings,
e Specified point receptors,
e Output grids.
Additionally,
e Grid sources and aircraft sources can be displayed,
e Specified points given in an *.asp file can be displayed,
e Terrain and roughness files can be visualised,
e A background map can be added to the Mapper to assist in locating features,

e Model output can be displayed in the Mapper as contour or vector plots by using
the 2D output plotter,

e A 3D visualisation of the features can be made.
Instructions on how to launch the Mapper are in Section 1.2.

Figure 1 shows the Mapper with the main features labelled. The menu options available
from the menu are described in Section 1.3, the key interactions available are discussed
in Section 1.4, right-click pop-up menus are described in Section 1.5 and the toolbar
buttons in Section 1.6. The remaining parts of the Mapper, the layer panel and the map
view window, are discussed in Sections 1.7 and 1.8 respectively. Instructions on how to
set the coordinate system in the Mapper are given in Section 1.9.

Following this introduction, Section 2 describes how to set up and save an Mapper
project file and edit features of the ADMS input using the Mapper; Section 3 explains
how to view model results in the Mapper; Section 4 describes how to modify the
appearance of a layer; finally Section 5 deals with additional items such as importing
background images, visualising input in 3D and exporting to Google Earth, together
with other advanced features.
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SECTION 1 —Introduction to the Mapper

Menu bar Map view

@ADMS Mapper / E@
File Edit Help

Toolbar \ﬁ 3 FT EHRELAO < Qav|--kah T
U~ Lapers | Gwmpig | ® |
; =] P‘oinl sources (1) i‘ i DRecemor 1
: = [w] Specified paints (3] :

Layers tab o= :
| ™ : Receptor 2
1 =
I | |E [w] Line sources (0] :
|/ :
| B [w] Road sources (0]

Layer panel [ =% |/ '
: B[] Buildings (1) : o
|| i
HiE Area sources (0] [ Receptor 3
| : “
: = [w] ¥olume sources (0] :
| i
| B [w] Grid source cells (0] ~ |
1| uo 1 B i

Attributes ——— $~ A :
|| Geanesy P i
: ADMS-Urban View : T
1

Status bar ;;Ie; l;en_cﬁs):o;m;p_lo;l;a\; ;Fo?m;tio:v about features ¥ -756.51097 : 309.88479 | Editing: none Scale: 1:6.610

Figure 1 - The Mapper with the main features labelled.
1.2 Launching the Mapper
To launch the Mapper from the ADMS model interface, select the Mapper menu item or
. iy
click on the J button on the Setup screen.
1.3 Menu options

There are two main menus: File and Edit. The File menu includes options to save, open
and close a project; to add, remove and export layers; to save layer settings or restore
the factory settings; to edit preferences for viewing and gridding options; and to exit the
Mapper. The Edit menu allows copying of images to the clipboard and allows any
changes made to the Sources, Buildings and Specified points layers to be saved to the
model. There is an option to extract data from raster layers. Finally, it also allows you to
define whether the coordinates are part of a known projected or geographic system, e.g.
Ordnance Survey OSGB coordinates, via the Set map coordinate system option — this is
described further in Section 1.9. Additionally there is a Help menu. The menu options
available are outlined in Table 1.
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SECTION 1 —Introduction to the Mapper

Menu Option Use

New Project Opens a new project.

Open project... Open a previously saved project file.

Save project Save the current project under the current file
name.

Save project as... Save the current project with a user-specified
file name.

Add layer Allows a layer to be added, e.g. a background
map.

Add WMS layer Allows you to add a URL for a WMS layer.

File Remove layer Removes the selected layer from the map view.

Export layer... Allows the selected layer to be exported to file
in a choice of formats.

Save all layer settings Saves the current appearance of the layers
(colour, symbol etc.) as the default appearance.

Restore factory settings Restores the default appearance of the ADMS
layers.

Snap to shape Option to snap to nearby shapes when adding
and editing vertices.

Preferences Display north arrow | Option to show/hide the north arrow.

Gridding option Allows selection of gridding method.

Close Closes the Mapper.

Save edits Saves the edits made to the model.

Copy map to clipboard Copies the current view in the map window to
the clipboard.

Copy legend to clipboard Copies the top part of the layer panel to the
clipboard.

Copy scalebar to clipboard Caopies the scalebar to the clipboard.

Edit Extract data from raster layers Converts raster data to comma delimited file
format.

Use the ADMS coordinate system | Sets the coordinate system used in the Mapper
to the same as that defined in the ADMS
interface.

Set map coordinate system This allows you to set the coordinate system to
a projected or a geographic system, or to turn
off the coordinate system.

Hel User guide Opens the Mapper User Guide.
e
P About Mapper Displays information about the Mapper, e.g.
version number and CERC contact details.

Table 1 - Menu options in the Mapper.
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SECTION 1 —Introduction to the Mapper

1.4 Keyboard & mouse interactions

There are several keyboard interactions for functions in the Mapper, as listed in Table
2.

Action Function

Layer panel

Pressing the delete key while a user layer is selected in the layer panel

Delete will delete that layer.

Pan and zoom

Holding down the shift key temporarily changes the mouse interaction

Shift — Mouse click with the map to pan, allowing you to move the map view.

Mouse wheel Rolling the mouse wheel back and forth zooms the map view out and in

When in zoom mode, holding down the control key whilst using the
mouse to zoom by click-and-drag will interactively scale the map image
to indicate the amount of zoom (in or out) that will be applied when you
release the mouse.

Ctrl — Mouse click

Editing
Delete Deletes the currently selected shape
Escape Cancels/reverts current edits/changes
Enter Completes current edits and deselects the shape, but doesn't save edits to
Double click the ADMS interface
Information
AltGr Ensures that only features in the currently selected layer can be clicked

Table 2 — Key interactions in the Mapper.

Note that the pan and zoom functions can be used whilst editing a feature. This is
useful, for example, if you are drawing a source which covers a large distance such as
a road.

1.5 Pop-up menus

You will find context-sensitive pop-up menus when you use the mouse to right-click
in the Mapper. These give quick access to relevant actions while you are working with
the Mapper.

1.5.1 The layer context menu

When you select a layer in the layer panel and right-click with the mouse, the
following context menu will appear. The menu is context-sensitive and only the menu
options that apply will be enabled.
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@ ADMS Mapper
File Edit Help
LIo¥ 2T R0
Layers Grouping 30
B [w] Point snures (11 Tal
® Settings 3
Bl Spe Use layer C5 for map
[m] Move up
Move down
| ]
B Lins Simplify layer
Refresh contours
= Roa Export layer 3
Clip layer to polygons
El [ Builg Statistics
Deselect layer
E1fA Areg Remove layer

The details of these actions can be found in the relevant sections of this document.

Menu option

Use

Layer settings

Opens the layer properties dialog. See Section 4 and Section 5

Import layer Changes the appearance of the layer. See Section 4.8
settings...

Export layer Saves the layer settings to file for re-use later. See Section 4.8
settings...

Reload default Resets the appearance of the layer. See Section 4.8

settings file

Settings | save default

Saves the layer settings as the defaults so they will automatically be

settings file used the next time you open the Mapper. See Section 4.8
View active Opens the current layer settings file in a text editor
settings file

Share colour ramp

Shares the colour ramp of the current layer (if any) with every other
layer of that type in that group

Share renderer

Shares the renderer of the current layer (if any) with every other layer
of that type in that group

Use layer CS for map

Sets the map coordinate system to that used by the current layer

Move up Moves the current layer up one level (only available in the Layers tab)

Move down Moves the current layer down one level (only available in the Layers
tab)

Simplify layer Simplifies the geometry of features belonging to the current layer if

possible. See Section 2.3.3.

Refresh contours

Redraws contour lines to match up with their associated contour layer.
See section 4.5.

Export layer

Quick access to common file export options such as ADMS SPT,
Google Earth and ESRI Shape. See Section 5.12

Clip layer to polygons

Creates a new layer containing features from the current layer clipped
to polygons from another layer. See Section 5.13

Statistics

Displays statistics about the current layer. See Section 5.14

Deselect layer

Deselects the currently selected layer in the layer panel

Remove layer

Removes the selected layer from the layer panel and map view. This is
only available for user layers. See Section 1.7.1.

ADMS Mapper User Guide
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1.5.2 The add/edit context menu

When adding or editing features in the map view you can display a pop-up menu
specifically dealing with different edit options when you right-click on the map or an

edited feature.

5 ADMS Mapper
File Edit Help

% ®¥

Layers Grouping 30

B[ Line soures (1] -]
B Road sources (0)

B [ Buildings [1)

[ EANAN

B[] Area sources (1]

&

N

B[] Vokme sauces (0]

Kl

A

B[ Grid source cels (0)

Kl

P

B ] Output grid extent

LR AR RN I

@ag|la-sabxs & i

e Delete feature

— Finish edit

Cancel edit
Undo
Redo

e edits

Clear all edits

\ Simplify

-1

The details of these actions can be found in the relevant sections of this document.

Menu option

Use

Delete feature

Delete the selected feature from the current layer.

Finish editing the currently selected feature without saving all edits. See

Finish edit Section 2.3.2

Cancel edit Cancel the edits to the currently selected and deselect it.

Undo Undo the edits to the currently selected feature without deselecting it.
Redo Redo the edits that have just been undone.

Save edits Save the edits made during the current editing session to the model.
Clear all edits Clear all edits made during the current editing session

Simplify Simplify the geometry of the current feature if possible. See Section

2.3.3.

Simplify to [n] vertices

Simplify the geometry of the current feature such that there will be n (or
fewer) vertices after the simplification. Option only available if the
current feature has more than the maximum number of vertices (n)
allowed by the ADMS model.

1.6

Toolbar buttons

The toolbar contains buttons that allow layers, features in the ADMS layers, and the
map view to be edited, as well as providing access to the 2D output plotter. The purpose
of each of the buttons is summarised in Table 3 and Table 4. The remaining sections
then illustrate how these are used to view, create and edit data.

When using a tool that requires the user to specify a location in the map view window,
the appearance of the cursor will change.

ADMS Mapper User Guide
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Button Name Cursor Function
. Export layer N/A Export the current layer to a file.
D Add background N/A Adds a background map to the map view window.
map
¥ Add layer N/A | Add a new layer from a file.
Remove the selected layer from the layer panel and map
% Remove layer N/A view. This is only available for user created layers.
Obtain the latest data from the model for all the layers and
% Refresh layers N/A update the map view.
Obtain the latest data from the model for the selected layer
b7 Refresh layer N/A and update the map view.
Zoom to layers N/A Set the map view to show all the data in all the layers.
y
Ao Zoom to layer N/A | Setthe map view to the extent of the selected layer.
& Zoom in N/A | Zoomin.
=4 Zoom out N/A | Zoom out.
Zoom to display an area defined by clicking with the mouse
Q Zoom Q on the map and dragging the cursor. A single left-click of the
mouse on the map will make a fixed zoom in at the point
clicked. A right-click will make a fixed zoom out.
(T Pan ITb Move the map view without altering the scale.
< Previous extent N/A | Return to the previously displayed extent in the map view.
= Next extent N/A | Go to the next extent in the map view window.
i ) Information @ View information about a model feature in the map view
! window.
= Extract data from N/A Convert raster data to comma delimited file format.
raster layers
Measure the distance between two or more points in the map
4 Measure iy view window.
. Add a feature to the selected layer, e.g. a point, a polygon
~+J | Add feature O otc.
. Save the edits made during the current editing session to the
o Save edits NA | el
21 Edit feature @ Edit the geometry of a feature in the selected layer.
o Shift feature + Move a feature in the selected layer.
| Delete feature N/A Delete the selected feature.
LY Rotate N/A Rotate the selected feature.
Y Undo N/A | Undo the current changes while editing.
c Redo N/A | Redo the last Undo.
]@ Contours N/A Launch the Output Plotter for concentration plots.
1__._’.; Flow field N/A Launch the Output Plotter for flow field plots.
Change view Toggle the map view between 2D and 3D mode. The icon
W= N/A changes depending on the map mode. When viewing in 3D

mode additional buttons are available as shown in Table 4.

Table 3 - Mapper toolbar buttons

ADMS Mapper User Guide
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Button Name Cursor Function
Changes the camera pan mode so that the
Hti' Camera @ camera position is changed by yaw and pitch
- position rotations. Use the drop down arrow to change
the mode.
Changes the camera pan mode so that the
Camera XYZ E]_lb camera position is changed by vertical

translations and left-to-right horizontal
translations.

Changes the camera pan mode so that the

camera position is changed by left-to-right and
@ Camera XY @ forward-and-backward translations in the
horizontal plane.

Changes the camera pan mode so that the

{&> | Camerarotation | =& camera position is changed by point-of-view
rotation.
t:} Sun position S Changes the light and shade of the display.

% Zoom Q Zoom in and out.

Table 4 - Mapper toolbar buttons for 3D display

The Add Feature button will change appearance depending on the layer currently
selected. For the Buildings, Area sources and Volume sources layers, the appearance of the
Add Feature button depends on the shape of the building/source to be added; this can be
changed using the drop down arrow to the right of the button. Some of the buttons are
only available under certain conditions; for instance, the Add Feature, Edit Feature and
Shift Feature buttons are only available if the current selected layer can be edited from
within the Mapper. If a button is not currently available it will be greyed out.

1.7 The layer panel

There are three tabs in the layer panel: Layers, Grouping and 3D. The first two tabs show
the ADMS data layers and a feature attributes table. The Layers tab lists the layers in the
order in which they appear in the map view. The Grouping tab groups the layers
according to their type, e.g. all source layers will be listed under the Sources group. The
3D tab shows the additional options for visualising in 3D. The 3D manipulation is
described in Section 5.10 and the Layers and Grouping tabs are described next.

1.7.1 Layers and Grouping tabs

The Layers and Grouping tabs show the ADMS data layers along with any user defined
layers, such as contour plots or background images. The layers that are present when the
parent interface and Mapper are first launched are referred to as ADMS layers. These
layers contain all the sources, buildings, and output locations for the *.apl or *.upl file
currently open in the model interface. Unlike user layers, you will not be able to delete
these layers directly from the Mapper layer panel. To update the display to reflect any
changes that have been made in the model interface, e.g. through opening a new *.apl or

ADMS Mapper User Guide Page 13
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*.upl file, or adding a new source, click on the Refresh All Layers button % on the
toolbar.

For each of the ADMS layers that can contain multiple features, the layer panel shows
the name of the layer, the number of features in that layer (e.g. the number of point
sources) and the symbol used to represent that layer. Details of how you can change the
symbology and other layer options are given in Section 4. The Output grid extent layer
only shows the name of the layer and the symbol used to represent the layer.

The number displayed in the layer panel provides a handy count of the number of
sources of each type that have been entered into the interface.

flow field plots generated using the Flow field button L2, or web map services (WMS),
background images and data layers added using the Add Layer button¥ (or drag-dropped
onto the layer panel). Any user defined layers can be removed by first selecting the
layer and then clicking on the Remove Layer button% ; alternatively they can be removed
by selecting the layer in the layer panel, right-clicking on the layer and selecting Remove
layer from the pop-up menu, or simply hitting the delete key on the keyboard. Details
about creating contour layers can be found in Section 3 and instructions for adding a
background map as a layer can be found in Section 5.2.

1.7.2 Attributes table

An Attributes table is displayed beneath the layer panel. The Attributes table is populated
when you select the Information tool and click on a feature; refer to Section 5.7 for full
details. The splitting and the sizes of the attributes table and layer panel can be adjusted
by dragging the horizontal divider. Similarly, the vertical divider between the layer
panel and the map view window can be adjusted.

1.7.3 Showing and hiding layers

If a layer is visible then the data contained in that layer are shown in the map view
window. A layer can be hidden by unchecking the checkbox next to the layer name.
To make the layer visible again recheck the checkbox.

1.7.4 Reordering layers

The ordering of the layers in the Layers tab determines the order in which they are
shown in the map view window. Features from layers at the top of the Layers tab are
shown on top of features from layers further down and thus may hide them from view.
There are three different ways to reorder the layers within the Layers tab:

1. Click on the layer you wish to move, holding down the mouse button. Once a
red bar appears, move the layer to its new position, and then release the mouse
button.

2. Use the Move up and Move down right-click options on a particular layer.
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3. Click on the layer you wish to move. Press and hold the Ctrl button and then

press the 1 or | arrow keys to move the layer up or down.

The symbol used to represent a layer can be made partially transparent to allow
features in layers below them to be seen. See Section 4.1 for more details on making
layers transparent. Note that layers cannot be reordered from the Grouping tab.

1.8 The map view window

The map view window is where the data from the current visible layers are shown. Both
the ADMS and user-defined layers are shown in this window. The scale of the map
view window is given as a scalebar in the bottom right corner of the map view window
and as a numerical scale on the right hand side of the status bar. The position of the
cursor in the map view window is given in the status bar, as well as the value at that
position if a raster layer containing data values is selected.

The scale and extent of the map view window is controlled by various toolbar buttons:

To zoom and centre the window on the features of all the (unhidden) layers click
on the Zoom To Layers button on the toolbar. ]

To zoom and centre the window on the features of the currently selected layer
click on the Zoom To Layer button on the toolbar. &

To zoom in to a central point in the map view window click on the Zoom In
button on the toolbar. &

To zoom out from a central point on the map view window click on the Zoom Out
button on the toolbar. =

To view a selected region in the map view window click on the Zoom button on
the toolbar. &

Click in the top left corner of the region you want to view, and while holding
down the mouse button drag the cursor to the bottom right corner of the region
you want to view, then release the mouse button to set the extent of the map
view window.

To move the view in the map view window without altering the scale click on
the Pan button on the toolbar. (3

Then click and drag the mouse in the map view window to move the view.

To return to a previous viewing extent in the map view window click on the
Previous Extent button on the toolbar. <

To go to the next viewing extent in the map view window click on the Next
Extent button on the toolbar ®. This option is only available after the Previous
Extent button has been used.
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1.9 Coordinate systems

There is an option to set the coordinate system within the Mapper. The choice of the
coordinate system affects the way the ADMS layers are shown in the Mapper map view
window. Note that the coordinate system must be selected before certain features of the
Mapper can be used; for example, before exporting Mapper files to *.kml files for use in
Google Earth.

Coordinate systems can also be defined separately for each layer. This is necessary to
ensure that additional features, such as background maps, use the correct coordinate
system for the data they are displaying. Typically you would set the map coordinate
system to match that used by the parent interface. However, if you have a lot of data in a
user layer with a different coordinate system, you might choose that for the map to
avoid CPU-intensive re-projection of the data as you move about in the map view. The
coordinate system for the ADMS layers should not be changed in the Mapper — this is
set for all ADMS layers in the model interface; see the relevant model User Guide for
more details.

Full details of how to set the coordinate system are given in Section 5.1.
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This section outlines how to use the Mapper to view, create and modify the geometry of the
model data. The model data that can be manipulated with the Mapper varies depending on
which model it is being used with, but include sources, buildings, specified output points,
output grids and terrain and roughness files.

2.1 Mapper projects

Mapper projects are a convenient way to manage files and data you wish to view in the
Mapper that are associated with a given task. Any data added to the Mapper project, such as a
background map or contour plot, will remain in the project after saving. The project will also
remember any custom settings for the ADMS layers that you may have configured. The file
name extension of a Mapper project file is *.mpj.

To save the current Mapper project, select the Save project command from the File menu, or, to
save the current project under a new name, select Save project as... from the File menu. Once
the project has been saved, the filename will appear in the form title at the top of the Mapper.
When using the Mapper with a compatible model, for example ADMS, the project will also
be entered into the Mapper project file panel on the Setup screen of the ADMS interface. In this
way you can associate *.apl or *.upl files with a project so that all your added data is loaded
automatically when you start the Mapper.

Note that the project file has a required associated file with the file extension *.ttkgproject. If
the Mapper project is moved to a different directory after it has been created, the associated
* ttkgproject file must be moved with it.

You can choose to open a Mapper project at any time, regardless of any *.apl or *.upl file you
may have loaded in the parent interface. This will display all the user layers referenced by the
project, and also apply the project configuration to the ADMS layers. It also reassigns the
Mapper project file in the parent (e.g. ADMS) interface.

To close the Mapper project, select the New command from the File menu, the current project
will then close, clearing all the user layers and project configuration settings, and leaving only
the ADMS data displayed in the Mapper using the default layer configurations.

To view existing data from an *.apl or *.upl file refer to Section 2.2; or to add, modify the
geometry of, move, or delete a feature refer to the instructions in Sections 2.3 to 2.10.

2.2 Viewing existing data

To view existing sources, buildings, specified output points, the output grid and output
points, first open the *.apl or *.upl file in the model interface. Then return to the
Mapper and click on the Refresh Layers button % on the toolbar. Some layers will only
appear in the Mapper once they have been selected for modelling in the parent interface.
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This can include buildings, specified output points, the output grid, complex terrain and
surface roughness options. For details of how to set these options see the model user

guide.

2.3 General source editing

This section covers how to add, move or delete sources using the Mapper. To follow
these instructions, make sure you already have the *.apl or *.upl file which is to be
edited open in the model interface, i.e. the file to which you wish to add, move or delete
sources. Also make sure that the Mapper is open.

2.3.1 Adding a source

Step 1

Step 2

Step 3

Step 4

Step 5

Select the appropriate layer in the layer panel e.g. the Point sources layer,
the Area sources layer etc.

Click on the Add Feature button on the toolbar to select it. Note that the Add
feature button changes appearance depending upon which type of source is
being edited. For example the Add feature button for point sources uses a
dot symbol, * . For area and volume sources, click on the drop down arrow
and select either Polygon or Circle.

Click in the map view window at the location where you want the source
to be placed. If you are adding a line source in ADMS 6 you will need to
click at the location of either end of the line; remember a line source must
have precisely two vertices in ADMS 6. If you are adding a polygonal area
or volume source, or a road or line source in ADMS-Urban, ADMS-Roads
or ADMS-Airport, you will need to click in the map view window at each
vertex location, and double click when placing the last vertex to finish
defining the source. If you don’t double click at the end of the drawing,
you can still complete the edit by pressing enter on the keyboard or right-
clicking with the mouse and choosing Finish edit from the pop-up menu. If
you are adding a circular area or volume source, you will need to click in
the map window on the location of the centre of the source, and while
holding down the mouse button, move the cursor until the circle is of the
required diameter before releasing the mouse button. This will create a
polygon representation of the circle.

When drawing road sources, for example, enable the Snap to shape option
from the preferences in order to easily connect road ends of adjoining
sources, or disable it for fine edits.

For non-point features such as area or volume sources, you will need to
click on the Save edits button on the toolbar, 44, to complete all editing in
the layer and commit the new features (alternatively, right click the mouse
to bring up a pop-up menu and select the Save edits option). Single vertex
features such as point or jet sources are added instantly when you click on
the map view using the mouse.

A new source of the appropriate type is created and displayed in the Source
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screen of the model interface. The source coordinates have been filled in
automatically but you will need to fill in the other parameters for the
source. Refer to the model user guide for further details.

2.3.2 Editing a source

Follow these steps to edit an existing source from within the Mapper.

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Select the appropriate layer in the layer panel e.g. the Area sources layer.
Click on the Edit Feature button on the toolbar to select it. £
Select the source you want to edit by clicking on it.

If you are editing a source with multiple vertices (e.g. area source) and
wish to add a new vertex, do as follows. Click on the starting vertex of the
edge you wish to split into two, e.g. click on vertex 3 if you wish to add a
new vertex between the current vertices 3 and 4. The selected vertex
should turn red, with the rest of the vertices coloured green. Alternatively,
use either the full stop (.) or comma (,) keys on the keyboard to select a
different vertex. Then click on the location of the new vertex.

For multiple vertex sources, the modified shape of the selected source will
appear as a dashed line during editing.

To move a vertex, click and drag that vertex to the new location before
releasing the mouse button.

To delete a vertex, click on the vertex you wish to delete in order to select
it, and then click on that vertex again.

If you want to edit other sources in the same layer without saving all edits,
you can complete the current edit by pressing enter on the keyboard or
right-clicking with the mouse and choosing Finish edit from the pop-up
menu. You can now select another source to edit as in Step 3.

Click on the Save Edits button on the toolbar to save the changes to the
model.44. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.
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Figure 2 — Pop-up menu showing editing options.

2.3.3 Simplifying source geometry

When you are editing a source with multiple vertices (e.g. a road source) you can use
the Simplify option from the right-click pop-up menu in Figure 2 to reduce the number
of vertices. This will remove as many vertices as possible while preserving the
approximate shape of the original source. Simplify uses the Douglas-Peucker vertex
removal algorithm with a tolerance of 1 m to systematically remove vertices and
simplify the polyline or polygon.

If the source being edited has more than the maximum number of vertices allowed by
the ADMS model, another option, Simplify to [n] vertices, will become available from
the right-click pop-up menu. This will force the simplification to result in n (or fewer)
vertices, increasing the default tolerance of the algorithm if necessary.

There is also an option to simplify the geometry of all sources of a particular type
simultaneously. To do this, right-click on the appropriate layer in the layer panel, e.g.
the Road sources layer, and click Simplify layer. This generates a Simplify report that
displays the results of the layer simplification before they have been applied; an
example is shown in Figure 3. You should then choose whether to apply the layer
simplification by clicking either Save changes or Discard changes as appropriate. There
is also a Copy report button that allows you to copy the report text to the clipboard.

Running Simplify layer will ensure that no sources in the layer have more than the
maximum number of vertices allowed by the ADMS model.
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Figure 3 — Example Simplify report

2.3.4 Moving a source
Follow these steps to change the location of an existing source from within the
Mapper.
Step 1 Select the appropriate layer in the layer panel e.g. the Point sources layer.
Step 2  Click on the Shift Feature button on the toolbar to select it. H

Step 3  Click on the appropriate source, and while holding down the mouse button
move the cursor to the new location for the source before releasing the
mouse button.

Sstep 4 Click on the Save Edits button on the toolbar to save the changes to the
model.4d. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.3.5 Rotating a source

Line, road, area and volume sources can all be rotated in the horizontal plane within
the Mapper. To do this, follow these steps:

Step 1  Select the appropriate layer in the layer panel e.g. the Area sources layer.

Step 2 Click on the Rotate button on the toolbar to select it. 2

step 3 Click on the appropriate source, away from its centre, and while holding
down the mouse button, move the cursor around the centre of the source
until you are happy with its new location (indicated by a red outline),
before releasing the mouse button.

Step 4 Click on the Save Edits button on the toolbar to save the changes to the
model.44. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option
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2.3.6 Deleting a source
Follow these steps to delete an existing source from within the Mapper.

Step 1 Select the appropriate layer in the layer panel e.g. the Point Source layer.
step2 Click on the Edit Feature button on the toolbar to select it. £

Step 3 Select the source you want to delete by clicking on it in the map view
window.

Step4 Click on the Delete Feature button on the toolbar. 3. Or press the pelete
key on your keyboard.

step 5 Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Step 6 Repeat this process to delete further sources.

2.4 Grid sources and aircraft sources

Grid sources and aircraft sources can be displayed in the Mapper, but they cannot be
added, edited or deleted.

To view a grid or aircraft source add the source in the model interface following the
instructions in the ADMS-Urban or ADMS-Airport User Guide. In the Mapper click on
the Refresh Layers button¥8. The sources will now be displayed.

2.5 Specified output points

In this section we look at how to add, move or delete specified output points using the
Mapper. To follow these instructions, make sure you already have open in the model
interface the *.apl or *.upl file to which specified points are to be added, edited or
deleted. Also make sure that the Mapper is open. Also ensure that Specified points is
selected as an output location type in the Grids screen of the model interface.

2.5.1 Adding an output point
Step 1  Select the Specified Points layer from the layer panel.
Step 2 Click on the Add Feature button on the toolbar to select it. *

step 3  Click on the location in the map view window where you wish to place the
specified output point.

Step 4 A new specified output point has been created and is displayed in the Grids
screen of the model interface. The X and Y co-ordinates have been
automatically entered but the rest of the parameters need to be filled in.
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See the model user guide for more details.
Step 5 Repeat this process to add further specified output points.

2.5.2 Moving an output point
Step 1 Select the Specified Points layer from the layer panel.
step 2  Click on the Shift Feature button on the toolbar to select it. i

step 3 Click on the specified output point you wish to move, and while holding
down the mouse button, move the cursor to the new location for the
specified output point before releasing the mouse button.

step 4 Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Step 5 Repeat this process for all the specified output points you wish to move.

2.5.3 Deleting an output point
Step 1  Select the Specified points layer from the layer panel.
Step 2 Click on the Edit Feature button on the toolbar to select it. <1

Step 3  Select the specified output point to delete by clicking on it in the map view
window. The selected specified output point will have a red dot on it.

Step4 Click on the Delete Feature button on the toolbar, ¥, or press the Delete
button on your keyboard.

Step 5 Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Step 6 Repeat this process to delete further specified output points.

2.6 Specified output points file

If you wish to add a large number of specified points you can do this quickly by
including an *.asp file in the ADMS model interface to define their locations. Refer to
your model user guide for instructions on how to do this. The locations of the specified
points defined in the *.asp file can be viewed in the Mapper by following these steps.

Step1  Add the file path for the *.asp file to the model interface, refer to the model
user guide for instructions on how to do this.

Step2  In the Mapper click on the Refresh Layers button¥. The specified points in the
*.asp file will now be displayed.

The specified points in the *.asp file cannot be edited or deleted using the Mapper; this
can be done only by editing the *.asp file directly.
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For very large *.asp files, only the first 500,000 points will be displayed.*

2.7 Output grid

In this section we look at how to define a new output grid using the Mapper. To follow
these instructions, make sure you already have open in the model interface the *.apl or
*.upl file with the output grid you wish to redefine, and ensure that the Mapper is also

open.

Regular and variable grids can be displayed in the Mapper, but only regular grids can
be defined using the Mapper. Variable grids must be defined in the ADMS interface.
Therefore, if you wish to define the output grid with the tool in the Mapper, ensure
that Gridded output points is selected as an output location type and the gridded output
spacing set to Regular in the Grids screen of the model interface.

You can only redefine or move an output grid; you cannot edit or delete an existing

output grid.

2.7.1 Defining an output grid

Step 1

Step 2
Step 3
Step 4

Step 5

In the ADMS interface, ensure that Gridded output points is selected as an
output location type and the gridded output spacing set to Regular in the
Grids screen.

Select the Output grid extent layer in the layer panel.
Click on the Add Feature button on the toolbar to select it. [d

Click on the location of one corner of the output grid in the map view
window, and while holding down the mouse button, move the cursor to
draw the output grid required before releasing the mouse button.

A new output grid has been defined and is displayed in Grids screen of the
model interface. The new extent of the grid will have been filled in
automatically but if any other parameters need to be changed these must be
altered from the interface. Refer to the model user guide for more details.

Note that the grid point locations are shown in the Output grid points layer but
they cannot be edited in the Mapper. The number of points in the grid is
displayed in brackets.

Any type of grid point can be displayed in the Mapper.

2.7.2 Editing the output grid

Step 1
Step 2

Select the Output grid extent layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. £

! The maximum number of data points shown in any layer can be edited manually in the Mapper settings file.
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Step 3

Step 4

Step 5

Step 6

Click anywhere within the current output grid extent. Three of the grid
vertices will appear as green dots and the fourth vertex as a red dot.

The vertex with the red dot indicates which corner of the output grid will
be movable. To select a different vertex, use either the full stop (.) or
comma (, ) keys on the keyboard.

Click in the map window, and while holding down the mouse button,
move the cursor until the red grid vertex is in the desired location before
releasing the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.7.3 Moving the output grid

Step 1  Select the Output grid extent layer from the layer panel.

Step 2 Click on the Shift Feature button on the toolbar to select it. H

step 3 Click anywhere within the current output grid extent, and while holding
down the mouse button, move the cursor to the new location for the output
grid before releasing the mouse button.

Step 4 Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.8 Buildings

This section outlines how to add, move, edit or delete buildings using the Mapper. To
follow these instructions, make sure you already have open in the model interface the
*.apl or *.upl file to which buildings are to be added, edited or deleted. Make sure that
the Mapper is also open. Also make sure that the Buildings option is selected in the Setup
screen of the model interface.

Rectangular buildings must consist of 4 vertices and be rectangular in shape. If the
shape entered is not rectangular but is convex and has 4 vertices then the Mapper will
convert the shape to be rectangular.

The main building will be shown with a red outline. See the relevant model User Guide
for more details about setting the main building.

2.8.1 Adding arectangular building

Step 1
Step 2

Step 3

Select the Buildings layer from the layer panel.

Use the drop down arrow on the Add Feature button on the toolbar to select
Polygon and then click on this button to select it. <J

Click in the map view window on the locations of the four vertices of the
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Step 4
Step 5

Step 6

building in order, either clockwise or anticlockwise. Double click when
placing the last vertex to finish defining that building. Alternatively, press
enter on the keyboard, or right-click with the mouse and choose Finish edit
from the pop-up menu, after placing the last vertex.

Repeat this process to add further rectangular buildings.

Click on the Save Edits button on the toolbar to finish editing and save the
changes to the model. 4. Alternatively right click the mouse to bring up a
pop-up menu and select the Save edits option

The new buildings will have been created and are displayed in the Buildings
screen in the model interface. Enter the rest of the parameters for these
buildings and then exit the Buildings screen. See the model user guide for
more details.

2.8.2 Adding a circular building

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6

Select the Buildings layer from the layer panel.

Use the drop down arrow on the Add Feature button on the toolbar to select
Circle then click on the button to select it. <

Click in the map view window on the location of the centre of the
building, and while holding down the mouse button, move the cursor until
the circle is of the appropriate diameter, and then release the mouse button.

Repeat this process to add further circular buildings.

Click on the Save Edits button on the toolbar to finish editing and save the
changes to the model. 4. Alternatively right click the mouse to bring up a
pop-up menu and select the Save edits option.

The new buildings will have been created and are displayed in the Buildings
screen in the model interface. Enter the rest of the parameters for these
buildings and then exit the Buildings screen. See the model user guide for
more details.

2.8.3 Editing a rectangular building

Step 1
Step 2
Step 3

Step 4

Step 5

Select the Buildings layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. <1

Select the rectangular building whose geometry you wish to alter in the
map view window. The vertices of the selected building will appear as red
or green dots.

For each vertex you want to move, click on that vertex, and while holding
down the mouse button, move the cursor to the new location of that vertex
before releasing the mouse button.

Click on the Save Edits button on the toolbar to finish editing this building
and save the changes to the model. 4. Alternatively right click the mouse
to bring up a pop-up menu and select the Save edits option.
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Step 6

Repeat this process to edit the geometry of further rectangular buildings.

2.8.4 Editing a circular building

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Buildings layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. £

Select the circular building whose geometry you wish to alter in the map
view window. The outline of the selected building will appear as a series
of green or red dots.

Click in the map window, and while holding down the mouse button,
move the cursor until the circle is of the required diameter before releasing
the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to edit the geometry of further circular buildings.

2.8.5 Moving a building

Follow these instructions to use the Mapper to change the location of an existing
building, either rectangular or circular, without altering its shape.

Step 1
Step 2
Step 3

Step 4

Step 5

Select the Buildings layer in the layer panel.
Click on the Shift Feature button on the toolbar to select it. £33

Click on the building you wish to move, and while holding down the
mouse button, move the cursor to the new location of this building before
releasing the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 44. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to move other buildings.

2.8.6 Rotating a building

Buildings can also be rotated in the horizontal plane within the Mapper. To do this,
follow these steps:

Step 1
Step 2
Step 3

Select the Buildings layer in the layer panel.

Click on the Rotate button on the toolbar to select it. “

Click on the appropriate building, away from its centre, and while holding
down the mouse button, move the cursor around the centre of the building
until you are happy with its new location (indicated by a red outline),
before releasing the mouse button.

ADMS Mapper User Guide Page 27



SECTION 2 -Using the Mapper

Step 4

Click on the Save Edits button on the toolbar to save the changes to the
model.44. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.8.7 Deleting a building

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Buildings layer in the layer panel.
Click on the Edit Feature button on the toolbar to select it. <1

Select the building you wish to delete by clicking on it in the map view
window. The vertices of the selected building will appear as red or green
dots.

Click on the Delete Feature button on the toolbar, 3. Or press the Delete
button on your keyboard.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to delete further buildings.

2.9 Coastline

This section outlines how to edit the coastline properties using the Mapper. To follow
these instructions, make sure you already have open in the model interface the *.apl or
*.upl file to which the coastline properties are to be edited. Make sure that the Mapper is
also open. Also make sure that the Coastline option is selected in the Setup screen of the
model interface.

2.9.1 Coastline

The coastline is represented by a line between the two coastline vertices. The Coastline
layer can be manipulated in the following ways:

e The Add feature button ¢ can be used to redraw the coastline. Press the mouse

button down at the location of the first vertex, hold the mouse button down and
drag the cursor to the location of the second and then release the mouse button.

The Edit feature button A can be used to move one of the vertices of the
coastline. First click on the coastline then click and drag the vertex to move it
to its new location. Then click the Save edits button .

The Shift feature button o can be used to move the whole coastline. Click and
drag on the coastline to move it to the new location and then click the Save edits
button 4.

The Rotate button 2 can be used to rotate the coastline about its centrepoint.
Click and drag on the coastline to put it in the new orientation and then click
the Save edits button #s.
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2.9.2 Coastline point on land

The coastline point on land is represented by a single point. This point can be moved
in the Mapper by first selecting the Coastline land layer in the layer panel, then selecting

the Add feature button * and clicking in the new location. This point must be at least
0.1 m away from the line representing the coastline.

2.10 Terrain and roughness files

Any complex terrain or variable surface roughness that has been included in the model
can be visualised in the Mapper. To view this data in the Mapper, first make sure that
the complex terrain option has been selected in the model interface and that either the
terrain file path (*.ter) or the roughness file path (*.ruf) has been selected and
specified. Refer to the model user guide for further details on modelling and including
complex terrain and variable roughness.

After the complex terrain file(s) have been included click on the Refresh Layers button
% in the Mapper. A representation of the variable terrain or surface roughness, or
both, will then be displayed in the map view window. Initially, the variable terrain or
roughness layer is shown with a default colour scale and default number of height or
roughness levels. These can be edited; see Section 4.6.

It is possible to view a 3D visualisation of the terrain and other input. Further details
on this are given in Section 5.10.

Extremely large terrain and roughness files can be displayed in the Mapper, but only
the first 500,000 points will be displayed. This limit can be changed in the Mapper
settings file, or alternatively the terrain file can be converted to a grid instead; see
Section 5.6 for more details.

ADMS Mapper User Guide Page 29



SECTION 3 Viewing model results in
the Mapper

Contour and vector plots of model output results can be created and viewed in the Mapper.
The 2D output plotter can produce contour plots using the in-built interpolator, or using
Golden Software’s Surfer, if the user has this program installed. Section 3.1 describes how to
plot model output. Section 3.2 describes how to plot flow field output. For details on changing
the appearance of a contour layer once it has been produced refer to Section 4.5.

3.1 Contour plotting

Step 3  Use the File > Preferences > Gridding option menu to select the Interpolator or the
Surfer option as desired and then click on the Contours button. 1@

Step 4  The 2-D Output Plotter screen will appear. The Interpolator mode is shown in
Figure 4.

Output type

* Contour

" Flow field

" Temperature and huridity

il

Cloge

Path: d\Examples Dataset to plot

| = - Scurce 1

(L1 E=ample10
[_] Examplest

Time [year. day. hour]
Example2.gst
Example3.gst

I Show specifisd points fles

Advanced Dptions. .. | Grid zettings : 400 = 400 grid lines - M atural Meighbour

Short-term files (< GST.%PST] Min: [GEVS

Figure 4 - The 2-D Output Plotter (Contour) with Interpolator screen.

Step 5  Select the file type (short or long term), the file containing the results, the
Dataset and the Time (if required) to be plotted.

Step 6  If required, use the Advanced Options... button to change the number of grid
lines or to specify user defined contour levels, as shown in Figure 5. The
Gridding method can also be changed. The options available with the
Interpolator option are Inverse Distance, Kriging, Kriging (all points), Natural
Neighbour and Triangulation (additional options are available with Surfer). The
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appearance of the output contours will depend on which of these has been
chosen. Natural Neighbour is a suitable choice in most instances. Once
advanced options have been selected, click Close to return to the main output
plotter screen.

Advanced Options
Gridding options
IV Specify rumber of grid lines Contour gridding method
& i o 200 | Natural Meighbour -]
¥ only, auto-calculate Y
v I—ZDD “ector gridding method
" only, auto-calculate X |Natulal Meightowr J
Contour levels
| [Bukomnatic) j &
~
Current reference point
r 4 Termain gridding methad
| |Nalura\ Meighbour J
ak Cancel
A grid with = columns and ' iows will be used Iir: b ax:

Figure 5 - The Advanced Options screen for the ADMS Contour Plotter with
Interpolator.

step 7  Click on the Plot button.

Step 8  You are asked to enter a name for the grid file. After entering a file name
click on the Save button.

Step 9  The contour layer will appear in the Mapper map view window, along with a
layer for the contour lines.

Figure 6 shows an example of a contour plot in the Mapper.

5. ADMS Mapper == (=R~
Eile Edit Help
¥R L a0 e @ae|- -~ Eolwd-~
Layers Grouping ER)
A

B

1[4 Volume sources ()
B[ Giid source eells (0)
E1[ Output ard extent

E1[] Qutput points (351)

+
B [#] Methane ppb contours

B[ Methane ppb
[_lo

150

[_]100
] 150
[ 200
[ 250
[ Eu

0.5 km

Moves the map ta its previous extent #: 27154156E+05 - 1.980041E+05 | Editing: none Scale: 1:22,100

Figure 6 — Example contour plot.
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3.2 Flow field plotting

Step1  Use the File > Preferences > Gridding option menu to choose either the Interpolator
or Surfer option. Click on the Flow field button.lz The rest of this example
assumes that the in-built interpolator has been selected.

Step 2 The 2D Output Plotter screen will appear, as shown in Figure 4.

&% 3-D Output Plotter (Plotting in Mapper with Interpolator) @
Output type File type
" Contour + Besults for each met, condibiorg E
{* Flow field ™ Resultz averaged over all met. conditions
™ Temperature and humidity Cloze
Fath: D:“\Examples Type of graph Height [m)
=4 =l | 6 wind st
0
U
o v
W
" Us longitudinal
™ Uy transverse
Format of Graph
{* Cantaurs
™ Turbulence [ms-: (™ Wectars (wind plats only)
i
i+
i
~ {=
("
r
Advanced Options.... | Grid zettings : 200 = 200 grid lines - Natural Meighbour
Choose this option ta plat autput for each met. condition Min: tdax:

Figure 7 - The 2-D Output Plotter (Flow field) with Interpolator screen.

Step 3  Select the file type (Results for each met. condition or Results averaged over all
met. conditions), the file containing the results, the type of graph (Wind or
Turbulence), the height for which the flow field is to be plotted and the format
of the graph (Contours or Vectors). If contours are being plotted then you must
select which component of the flow field or turbulence that you wish to plot.

Step 4  If required, use the Advanced Options... button to change the number of grid
lines or to specify user defined contour levels, as shown in Figure 5. The
Gridding method can also be changed. The options available with the
Interpolator option are Inverse Distance, Kriging, Kriging (all points), Natural
Neighbour and Triangulation (additional options are available with Surfer). The
appearance of the output contours will depend on which of these has been
chosen. Natural Neighbour is a suitable choice in most instances. Once
advanced options have been selected, click OK to return to the main output
plotter screen.

step5  Click on the Plot button.

Step 6  You are asked to enter a name for an intermediate file. After entering a file
name click on the Save button.

Step 7 The plot will appear in the Mapper map view window.
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Figure 8 shows an example of a flow field vector plot in the Mapper.
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Figure 8 — Example vector flow field plot.
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3.3 Displaying footprints

After performing an ADMS model run in which the Output per source option was
selected, it is possible to visualise the data in the extra output files created by this option
(.sst/.slt files) in the Mapper. These files contain the short-term/long-term contribution
of each source to the concentration and/or deposition at each specified receptor point.
The data to be viewed in the Mapper is controlled via a form that is launched from the
model interface; refer to the model user guide for full details.

An example visualisation in the Mapper is shown in Figure 9. Each included source is
filled with a colour that indicates to what degree it contributes to the concentration at
the selected receptor, as indicated by the blue square. The default colour scales can be
modified if desired; refer to Section 4.

15 ADMS Mapper =R B

File Edit Help
“IeF7 BT RRaa 40 Qavs|-~kah &|wad-
Layers Grouping 30

[ [ Paint Factprint (2) ﬂ
o =1

o 58
© 64
@ &1
@ &8
Lir

= e Footprint (0]
(1 [ Road Footprint (5]
1}

3 =]
7
/‘H

/1? j o

Elevation v -
® 54488574 | |

¥ 2588033

15T arget Tie

4 [m

ADMS-Utban Wigw 150m

Click to 2oom out »: B 443354E +05 v 2 693R12E+05 | Ediing: none Scale: 1:6.440

Figure 9 — Example footprint plot.
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3.4 Viewing numerical results

After an ADMS model run numerical results are written to *.gst, *.glt, *.pst, or *.plt
files (see the relevant model user guide for further details). The data in these files can be
displayed as a new layer in the Mapper. The example below is for a *.gst file, but the
method is similar for the other file types.

Any data file that is in comma-separated format can be displayed as a layer in the
Mapper provided it has some spatial information to place the data on the map. See
Section 5.5 for more details about this feature.

step1  Click on the Add Layer tool¥. A new window will appear as shown in

Figure 10.
@Add Layer @
@@v| v Computer » Local Disk (D) » Example - | +,| | Search Example j e [
Organize = MNew folder = 0 @
. 9% Favorites MName Date modified Type
Mo items match your search.
* 7 Libraries
> /M Computer
E‘I-I Metwork

4 1 b

File name: - |Cnmmnn files V|

Open - Cancel
|

Figure 10 — Add Layer window.

Step 2  Change the file type from Common files to All Files (*.*).

Step 3 Navigate to the *.gst file you wish to view and click Open. A new window
will appear as shown in Figure 11.

As an alternative to Steps 1-3, the file can be drag-dropped from Explorer onto
the layer panel.
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@Select data to use in layer: Examplel .gst = @
File: [:A\ExampleshExample.gst Lines: 2884
Start line: |2 End line: |2884 [V End of file Delimiter: |. Reload
Year Day Howr Timelz) ) ¥lrm] Zlm] Conclug/m3l -
# Y'ear Day Hour Time(s] ] ) Zlm Conclug/m3l:
1 Year Dray Hour Time(z) #[m) ) Z[m] Conclug/m3l:
2 1 333 333 -933 0.00 -200.00 0.00 0.500000E 4
3 1 333 333 -333 106.67 -200.00 0.00 0.500000E 4
4 1 333 -333 -933 21333 -200.00 0.00 0.500000E 4
5 1 933 993 -999 320,00 -200.00 0.00 0.500000E 4+
6 1 933 993 -999 42667 -200.00 0.00 0.500000E +
7 1 433 995 -999 53333 -200.00 0.00 0.500000E +
8 1 933 -993 -939 E40.00 -200.00 0.00 0.500000E +
9 1 -933 -993 -999 T4E.67 -200.00 0.00 0.500000E +
10 1 333 333 -933 85333 -200.00 0.00 0.500000E 4
11 1 333 333 -333 960.00 -200.00 0.00 0.500000E 4
12 1 933 -333 -333 1066.67 -200.00 0.00 0.500000E 4
13 1 933 993 -999 117333 -200.00 0.00 0.500000E 4+
14 1 933 993 -999 1280.00 -200.00 0.00 0.500000E +
15 1 433 995 -999 1386.67 -200.00 0.00 0.500000E +
16 1 9335 -993 -999 149333 -200.00 0.00 0.500000E +
17 1 -933 -993 -999 1600.00 -200.00 0.00 0.500000E +
18 1 333 333 -933 1706.67 -200.00 0.00 0.500000E 4
19 1 -333 -333 -933 181333 -200.00 0.00 0.500000E 4+
20 1 333 -333 -333 1320.00 -200.00 0.00 0.500000E 4+ -
4 13
0 Gota line ™ Convert data to grid using: Matural Neighbour + K Cancel

Figure 11 — Data from *.gst file

Step 4  This window can be used to select which data you wish to display in the
Mapper. By default all of the data is selected. To change the selection first
scroll to the desired start line of data and right click on the index (the number
in blue) for that line. When the menu appears select Set as first data line. An
example is shown in Figure 12 for which the data for hour 2 is being selected
for display in the Mapper.

?\/ Select data to use in layer: Examplel .gst ?@
File: D:AEwamplesExamplel.gst Lines: 2854
Start line:  [963 End line: |1923 [ End of file Delirmiter: |, Feload
Year Diay Hour Time(s] ) ¥[m] Zlm) Conclug/m3| -
957 1 999 999 999 2BBE.67 320000 0.00 0.500063E4
958 1 -939 -399 -939 277333 320000 0.00 0.500129E 4
959 1 -939 -399 -939 2880.00 320000 0.00 0.500239E 4
960 1 999 999 999 298667 320000 0.00 10.500406E 4
961 1 -939 -399 -939 309333 320000 0.00 0.500640E 4
962 1 -939 -399 -939 3200.00 320000 0.00 0.500954E 4
|983 S — =oH 9939 0.00 -200.00 0.00 [0.500000E 4
964 Set as first data line 3 -333 106.67 -200.00 0.00 0.500000E+
965 Set as last data line ] 933 213.33 -200.00 0.00 0.500000E 4
966 ] 999 320.00 -200.00 0.00 10.500000E 4
967 Copy to header 3] -339 426,67 -200.00 0.00 0.500000E 4
968 2 939 99 -339 533.33 -200.00 0.00 0.500000E 4
963 2 999 -999 999 E40.00 -200.00 0.00 10.500000E 4
970 2 -339 -399 -339 74667 -200.00 0.00 0.500000E 4
971 2 -339 -399 -339 853.33 -200.00 0.00 0.500000E 4
972 2 999 -999 999 960.00 -200.00 0.00 10.500000E 4
973 2 -339 -399 -339 10BE.E7 -200.00 0.00 0.500000E 4
974 2 -339 -399 -339 117333 -200.00 0.00 0.500000E 4
975 2 -9933 -933 -9933 1280.00 -200.00 0.00 0.500000E 4
976 2 -339 -399 -339 138667 -200.00 0.00 0.500000E 4
977 2 -939 -399 -939 149333 -200.00 0.00 0.500000E 4 -
a4 »
a Gotaline | Convert data to grid using: Matural Meighbour + OK Cancel
Figure 12 — Setting the first data line
Sstep 5  Similarly, to set the last data line scroll to the desired line, right click on the

index, and click in Set as last data line. The selected lines will be highlighted in

green.
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Step 6

The information at the top of the window shows you how much data is in the
file and which lines of data have been selected.

At this point you have the option to grid the selected data or add it as a set of
discrete points. To grid the data select the tick box beside the Convert data to
grid option; see Section 5.5 for more details about displaying data. Once you
have selected the data that you wish to display click OK. If you have not
gridded the data, it will then be displayed in the Mapper using the default red
square symbol as shown in Figure 13.

@ADMS Mapper
File Edit Help

LOFER RTBERASIGO e @as|. - & wd-
Layers Grouping an

2 [w] Example1 [361) i‘

= HoR =

B[] Foint sources 11
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...............................

B[] Line sources [0

-------------------------------
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B[] Road sources [0]

NiN

BOMsssucesl | L s mssssEsssEssssEEsssEssEE 8@

1 (el
...............................
Bl]Voumesouces(0) | L g sEssssEsEEEESESEEEEEESEEEES

Ad 00| sesssssssssssssssssssssssssssss

-------------------------------
B[] Grid source cells (0]

B[] Dutput grid extent

uip 1
oo Painl sources
Mame Source 1

Geomety  Foint

ADMS-Urban Wiew

4dd & user-specified layer to the map

#e 32526384 Y 3N 4797 | Editing: none

Scale: 1:26,100

Figure 13 — Data from the *.gst file displayed in the Mapper.

Step 7 Information about the data can then be viewed. Ensure that the data layer is
selected in the layer panel. Select the information tool @ and click on one of
the data points. Full details on the information tool can be found in Section
5.7. Information is then displayed at the bottom of the layer panel in the
Attributes table. The information includes the name of the point, its elevation
and location, the hour or time for which the data comes from, the pollutant
concentrations at that point, and the spatial extent of the whole data in the

data file.

It is possible to colour the points according to their concentration, for
example, as shown in Figure 14. By importing a configuration file you can
quickly apply the same colour settings to multiple layers. See Sections 4.6 and
4.8 for further details.
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5 ADMS Mapper = B 5

File Edit Help
ks PREIZTIER]YIQED @ [ F=ry 2 & md-
Layers Grouping E)

O [w] Examplel (367) i‘
oo

20

© BD

= 20

B[] Paint sources [1)
[ ] = " " = » " = » » = " » =

B[] Line saurces (0]

- - . . - . . - . . . . . . -
B[ Rioad sources (1)
B[] Avea sources (0]
B[] Yolume sources (0] -
300
Click and drag over an area to extract data from raster layers H 17547791 Y2 23316731 | Editing: none Secale: 1:11.300

Figure 14 —Numerical data displayed in the Mapper coloured by concentration.
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SECTION 4 Modifying the appearance
of layers

This section outlines how to modify the appearance of layers. The types of modification that
can be made depend on the type of layer you wish to modify. Sections 4.1 to 4.7 give details
of various different types of modification that can be made and the types of layer to which
these modifications can be applied. After modifying the appearance of the ADMS layers the
new appearance can be saved as the default appearance for ADMS layers by selecting Save all
layer settings from the File menu. The default appearance for ADMS layers can be restored at
any time by selecting Restore factory settings from the File menu. Note that this will save the
current appearance of all of the ADMS layers. The settings for individual layers can be saved
or reloaded by right-clicking on the layer and selecting Settings > Save default settings file or
Settings > Reload default settings file respectively. There is also the option to View active settings
file; selecting this option brings up a text file containing the current codes for the selected
layer. The settings for an individual layer can also be exported and then imported to other
layers, or imported in new maps later. This can be achieved by right-clicking on the layer and
selecting Settings > Import layer settings... or Settings > Export layer settings... as appropriate. These
options are discussed in Section 4.8.
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4.1 Modifying the transparency of a layer

The transparency of any layer can be changed. The transparency determines how “see-
through” the layer is and thus whether any features in a lower layer can be seen through
features in this layer. To change the transparency of a layer, follow these steps:

Step 1 Double click on the layer in the layer panel or select Settings > Layer settings
from the Layer context menu to bring up the layer properties window.

Step 2  Select General from the left panel and scroll to the Painting section, as shown

in Figure 15.
Vector: Point sources (1) @
+ X |P0int sources (1) i
Sertions Coordinate System
B Section 1 |UNKNO\"‘J'N (epsg:0) Select
Renderer
Marker Painting
Line
Area [ Bagemap Transparency
Label ) 100 -
Chart [v Cached Paint
0 [v¥ Ignore shape parameters
[~ Multipass rendering {slower!)
Scope {must be logical)
| = | E
[¥ Prefer styling from config file
Info
Eile information
Generic Vector Layer -
Extent :
XMin : -338.93 Al
User comments
=N~ | 7 -
Wizard ... oK | Cancel | Apply

Figure 15 - The General section of the layer properties screen.

Step 3  Alter the Transparency value as required. 0 is completely transparent and 100
is completely opaque.

Sstep 4  Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.
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4.2 Modifying the appearance of a marker layer

Markers are used to represent any layer of data defined as single points. For instance,
the ADMS layers for point sources are marker layers. To modify the appearance of one

of these layers follow these steps:

Step1  Double click on the layer of interest in the layer panel to bring up the layer
properties window, e.g. the Point sources layer.

Step2  Select Marker from the left panel, as shown in Figure 16.

Vector: Point sources (1)

+ K
General
Sections
B Section 1

Renderer
Line

Area
Label
Chart

3D

& &

Wizard ...

Visible
Marker
Style Calor Pattern
e o M | [ -]
Size Smart size
|8|:-t j |Eldeg J |16twips ﬂ
Qutline
Style Calor Pattern
| Bl
Width
2 twips -

¥ Indude in legend

CK | Cancel | Apply

Figure 16 - The Marker section of the layer properties screen.

Step3  The Marker and Outline sections can be used to alter the look of the markers
used to represent the features in this layer.

Step 4  Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.
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4.3 Modifying the appearance of aline layer

Coloured lines are used to represent any layer of data defined as lines such as line
sources. To modify the appearance of this layer follow these steps:

Step 1 Double click on the layer of interest in the layer panel to bring up the layer
properties window, e.g. the Line sources layer.

Step 2  Select Line from the left panel, as shown in Figure 17.

Vector: Line sources (1)

+ X
General
Sections
B Section 1

Renderer
Marker
pre
Label
Chart

30

& |

Wizard ...

visible
Line
Style Color Pattern
| <] (Moo <] [ s ] -]
Width
|10IJEIrn= j |IZ-:: J |IZ-:&; J
Smart size
12 twips -
Cutline
Style Color Pattern
| | [ <] [ ]
Width
1 twips -
[V Include in legend
oK | Cancel ‘ Apply ‘

Figure 17 - The Line section of the layer properties screen.

Step 3 The Line and Outline sections can be used to alter the appearance of the lines
used to represent the features in this layer.

Step 4  Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.
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4.4 Modifying the appearance of an area layer

Coloured areas are used to represent any layer of data represented by two-dimensional
regions in the Mapper, such as area or volume sources. To modify the appearance of
one of these layers follow these steps:

Step 1

Step 2

Step 3

Select Area from the left panel, as shown in Figure 18.

Double click on the layer of interest in the layer panel to bring up the layer
properties window, e.g. the Area sources layer.

Vector Area sources (1)

R R
General
Sections
B Section 1

Renderer
Marker
Line
Chart

3D

& K

Wizard ...

Area
Pattern Calor
EEpireE
|5t =] [spt x| |odeg -]
Smart size
12 twips -
Outline
Style Color Pattern
| | (Moo <] [[ow -]
Width
|2t'r\'i|:|s j |Elpt J |IZI deg J
v Indude in legend

0K | Cancel | Apply

Figure 18 - The Area section of the layer properties screen.

used in this layer.

Step 4

The Area and Outline sections can be used to alter the appearance of the shapes

Click on the OK button to make the changes and return to the Mapper

window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.
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4.5 Modifying the appearance of a contour layer

The colour scheme and number of contour levels used for a contour plot can be changed

either manually, by altering each of the individual levels, or by applying a new colour
scheme.

The contour levels can be manually altered by double clicking on the appropriate

contour layer in the layer panel to open up the layer properties window and then
selecting Grid from the left panel, as shown in Figure 19.

Raster: 502 ug/m3 @
+ > Grid
General
) Grid band
Sections
g Visihle 1 »| [ Shadow v Antialiasing
Grid
kn) Height threshold
Minimum value Maximium value
] 14,4104423522949
Ramp
Min Max Legend
o 2 g
j [ T -
2 4 2
= 4 5] 4
[ 8 [ =
W = 10 B
| Bl 12 10
B 14 12
- | BC 16 14 2

[~ Smooth colors

= |
Wizard ... oK | Cancel ‘ Apply |

Figure 19 - The Grid section for the layer properties screen for a contour layer.

To select a contour level, click on it. The following options are then available:

e Add a new contour level with the same properties as the current selected
contour level just above the current contour level by clicking on the Plus button
_* I'next to the contour levels.

e Delete the current selected contour level by clicking on the Minus button next

—_1to the contour levels.

e Delete all of the contour levels by clicking on the Cross button E next to the
contour levels.

e Alter the Min, Max or Legend values of the contour level by editing the contents
of the text boxes.
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e Alter the colour of a particular contour level by selecting it and then clicking
on the coloured rectangle to the left of the Min text box 1. This brings up the
Color screen, as shown in Figure 20. The colour can be changed by either
clicking on the colour wheel, using the sliders or editing the contents of the text
boxes. There are also some pre-set colours which can be viewed by clicking the
‘>” button. The lower slider (or Alpha text box) alters the colour transparency,
which can be useful for ‘seeing through’ certain regions of the contour plot.
Click OK or Cancel to return to the layer properties screen.

p -
Color
Preview
Alpha: |255

Red: |255 Hue: [T
Green: IE;_ Sat: [1&]—
Blue: lS_ Lum: [T

Cancel > |

Figure 20 - The Color screen

When the appropriate changes have been made, click on the OK button to make the
changes and go back to the Mapper window, click the Apply button to make the
changes but remain in the layer properties window, or click on the Cancel button to
discard the changes and return to the Mapper window.

A facility exists to automatically create a new graduated colour scheme for a contour
layer. To alter the colour scheme in this way, follow these instructions.

Step 1 Double click on the contour layer you wish to alter in the layer panel to bring
up the layer properties window.

Step 2  Click on the Wizard... button to start the Grid Ramp Wizard.

Step 3  Choose Simple classification to define a colour ramp with equally spaced
intervals or Advanced classification to get more interval spacing options, then
click Next >>. Choosing Simple classification brings up the window shown in
Figure 21.
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Step 4

Step 5
Step 6

Step 7

Step 8
Step 9
Step 10
Step 11

Step 12

Grid Ramp Wizard @

{+ Color

Start color Middle color End color
‘. DODOFF j ‘D DFFO00 j |. FFO000 j

[~ Add new ramp to existing ramp

(" Ramps

| Accents

<< Previous ‘

Figure 21 - The Grid Ramp Wizard screen for creating a new contour colour scheme.

Choose Color to select your own Start color, Middle color and End color, or Ramps
to choose from a pre-defined set of colour ramps, then click Next >>. Choosing
Color brings up the window shown in Figure 22.

-

Grid Ramp Wizard @
Minimal value Level every
0 0.144104423522949
[V Use average value Legend every
7.20522117614746 1.44104423522949
Maximal value
14.4104423522945
{<< Previous | oK Cancel

Figure 22 - The Grid Ramp Wizard screen for defining the intervals.

From here set the Minimal and Maximal values.

If required, set a middle value. If this is not required then uncheck the Use
Average value check box.

Set the spacing required between colour levels, Level Every, and the spacing
between legend entries, Legend Every.

Click on the OK button.
Uncheck the Shadow checkbox in the Grid section.
If required, manually edit the contour levels.

Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.

To update the contour lines so that they match the new contour levels, right-
click on the contour lines layer associated with the modified contour layer in
the layer panel, and click Refresh contours.
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4.6 Colouring alayer according to its properties

You may wish to colour a layer according to its properties. For example, you may wish
to colour a terrain file according to elevation; or a spatially varying roughness file

according to the roughness value; or you may wish to colour sources according to their
emission rates. This section describes how to make these changes.

layer, to bring up the properties window, see Figure 23.

Double click on the layer which you wish to modify, for example the terrain

Parameters

Path

EXH

-

MName

|Terrain file

Caption

|Terrain file (1024)

Coordinate System

|UMKNOWN (epsg:0)

Painting
| Basemap
[w Cached Paint
[« Ignore shape parameters
™ Multipass rendering (slower!)

Scope (must be logical)

Select

Transparency

Ca—

m

[v Prefer styling from config file

Info

Cancel |

Apply |

Figure 23 — The layer properties screen for a terrain file

Step 1
Vector: Terrain file (1024)
+ - X
General
Sections
B Section 1
Renderer
Marker
Line
Area
Label
Chart
30
= H
Wizard ...
Step 2
Step 3

Click on the Wizard... button to start the Rendering Wizard.
Choose whether to use a Simple or Advanced classification, then click Next >>.

Choosing Simple classification brings up the window shown in Figure 24.

Rendering Wizard

Formula (select field andfor add 50U like formula)

X5

|615_UID

{* Limited scan inside visible extent

{” Full scan of the layer (slower!)

<< Previous

=

Cancel

Figure 24 — The Rendering Wizard dialogue box
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Step 4  Using the drop down menu select the property according to which you wish
to colour the layer. For example, for a terrain layer select Elevation. Click on
Next>>.

Step 5  The next screen allows a choice between colouring by Unique values or by
Continuous values. The choice depends on the property you are using to colour
the layer. For the terrain layer, for example, it is appropriate to choose
Continuous values so there is a smooth gradation in colours from low
elevations to high elevations. On the other hand, when plotting surface
roughness, for example, the changes in roughness may be discrete, and it is
likely that there will be only a small number of different roughness values
across the region, so colouring by Unique values is more appropriate. The
choice can be made by selecting the appropriate radio button, and in the
continuous case you can also specify the range of values to use when
colouring the layer, see Figure 25. Click on Next>>.

Rendering Wizard @

" Unique values

Minimal value
From 650 records - |1. 1E-14
1.1E-14 )
3. 54F-14 Maximal value
1.056-13 |300
2.84E-13
7.08E-13 [ Use Average value
8.42E-13 |;5.:.
1L.61E-12 -

[T Use Logarithmic scale

=< Previous | MNext == Cancel

Figure 25 — Selecting unique or continuous values

Step 6  On the final screen make sure that Render by Color is selected and then click on

OK.
Rendering Wizard @
Features Render by
{o" Marker { Size [ Width
™ Line f* Color
(™ Area i~ Outline width

i~ Outline color

[v Indude in legend

<< Previous | 0K | Cancel ‘

Figure 26 — Render by Color

Step 7 The next step is to choose the colour scheme for the layer. The method for
doing this depends on whether the layer is being coloured by continuous or
unique values.

For continuous values select Renderer from the left panel, see Figure 27. You
can then change the minimum and maximum values at which the start and
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end colours will be applied, as well as the start and end colours themselves

using the drop-down menus.

b

Vector: Terrain file (1024) (=
s b4 Visible
General Renderer o
Sections
o Section 1 Render Expression (must be numeric) Round
Renderer Elevation ﬂ |u
Marker
Line First
Area ors
Label Number of zones Minimum value Maximium value
Chart 5 [11E014 [300
30
Start color End color Default color
‘D FFFFFF j |. 008000 j ||:| FFFFFF j i
Start size End size Default size
| 1 twips j | 24pt j |6 pt j
Second
Mumber of zones
|E| ||:| ||:|
‘. FFO00D J |. FFFFFF J |. FFFFFF J
& B —— N p— I ! i
Wizard ... QK | Cancel ‘ Apply |

Figure 27 — The Renderer section of the layer properties screen

For unique values, a separate colour can be selected for each individual level.
To do this, select the appropriate field, e.g. Marker, from each section listed in
the left panel in turn, as shown in Figure 28. Then choose the colour for that
level using the Color drop-down menu.
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Vector: Roughness file (1028) @
+ >< Visible Query[ Elevation=0.01]
General Marker
Sections
@ Other Style Color Pattern
| | (W <] [ ]
Renderer . .
: _
Line Size Smart size
Area |8 pt j Odeg J | 16 twips j
Label
Chart Outline
3D
| 0.1 Style Color Pattern

Width

Bl =l

Opt b
v Indude in legend
]
= =
Wizard ... OK | Cancel Apply

Figure 28 — The Marker section of the layer properties screen

Step 8  Finally, click OK to apply your changes.

If you wish to colour point sources by their emission rates, for example, then the steps
above can be followed, but at the stage when you select the formula from the drop down
window in the Rendering Wizard you should choose the pollutant emission rate with
which you want to colour the layer, e.g. [NOx (g/s)].

It is possible to define new formulas in the Rendering Wizard, e.g. if you wished to
colour area sources by their total NOx emission rate you could specify the formula:
[NOx (g/m2/s)]*GIS_AREA by typing in the formula box.
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4.7 Displaying feature names

Any of the default ADMS layers can display the names of the features within that layer.

To show these names follow these instructions.

Step 1 Double click on the layer of interest in the layer panel to bring up the layer
properties window.
Step 2  Select Label from the left panel, as shown in Figure 29.
Wector: Point sources (2) @
+ » Visible
General Value it
Sections
B Section 1 ﬂ
Line
Area Font
Chart =
- Arial x| [set =1 |. 000000 J
I~ r =
™ |
Label
|. FFFFO0 J | J
| 2500 twips | | 2500 twips | |aex -]
Qutline
= B | [ 11 | =
Wizard ... Ok | Cancel | Apply
Figure 29 - The Label section of the layer properties screen
Step 3 In the Value section, use the drop-down menu to set the Field to Name.
Step4  The Font, Label, Outline and Position sections can then be used to alter the
properties of the labels.
Step 5  The labels can be removed by unchecking the Visible checkbox in the Value
section.
Sstep 6  Click on the OK button to make the changes and return to the Mapper

window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes

and return to the Mapper window.
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4.8 Exporting, importing, saving and reloading layer
settings

Once the layers have been modified as desired the layer settings can be exported so that
they can be used in other layers or in other maps. Similarly, existing layer settings can
be imported. The layer settings can also be saved and reloaded. The steps are
highlighted in the examples below.

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Right click on the layer you wish to export. This brings up the menu shown in
Figure 30.

B 4DMS Mopper SR
File Edit Help
TR BT RNRAay GO @ag|: - Ex wd-
Layers Grauping 30 A
B Grid source cells () -]
[m]
[ [w] Output grid extent
=[] Output paints (361]
+
B [w] NOi ugdm3 contaurs
= ] NOx ugdm3 1
[Jo Settings 2 Layer settings
2
Cla P E e R e e e
— g Mmau Export layer settings... —
p Move down Reload settings file
[y
= %\i T Save settings file
(iR View active settings file
5 Refresh contours
3 Share renderer
2 Export layer 4
- B Share colour map
Clip layer to polygons
Statistics
Deselect layer
Remove layer
\'l 350
Create contour plot layer W -1266.4483 Y. -470.97786 | Editing: none Scale: 1:14,000

Figure 30 — The menu for exporting/importing layer settings.

Click on Settings > Export layer settings... .

A window opens prompting you to save the configuration file for the layer.
Choose a location and save the file with extension *.ttkstyle.

Right click on the layer to which you wish to import the settings. From the
menu select Settings > Import layer settings... .

Navigate to the layer configuration file that you have just created and click on
Open.

The layers are now displayed using the same layer settings.

The settings for an individual layer can be saved by right-clicking on the layer and
selecting Settings > Save settings file. These settings are then stored in a file so if you wish
to return to the saved settings, after making modifications, you can right-click on the
layer and select Settings > Reload settings file. This undoes any changes you have made.
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This section describes some of the more advanced features available in the Mapper.

5.1 Setting the map coordinate system

There are two aspects to consider when setting coordinate systems within the Mapper:
the map and the individual layers. The map coordinate system determines the way the
layers are displayed in the map view window, and you can choose one that suits your
needs provided it is compatible with the data. It can be either a projected or geographic
system. On the other hand, the layers each have a coordinate system, but these must
correspond to the data values in the layer. For example, the ADMS layers’ coordinate
system is set in the parent interface and acts on all the ADMS layers. This should be set
to whatever coordinate system you are using for your work in the model. For user layers
you often find the data have associated projection or world files that will define the
coordinate system for the layer automatically. This allows layers with data in different
coordinate systems to be projected correctly onto the map coordinate system for easy
comparison.

The map coordinate system is used as the default coordinate system for user layers with
no associated world file or other georeferencing information.

The coordinates of a point in the map view window (as given in the status bar) are in the
units associated with the map coordinate system. For example, if the map coordinate
system has been set to WGS 84 then the coordinates are degrees longitude and latitude.

The map coordinate system must be selected before certain features of the Mapper can
be used; for example, before exporting Mapper layers to *.kml files for use in Google
Earth.

The coordinate systems for the ADMS layers should not be changed in the Mapper —
these are set in the parent interface. See the relevant model User Guide for more
details.

To set the coordinate system that is used in the Mapper select either Use the ADMS
coordinate system or Set map coordinate system from the Edit menu, as shown in Figure 31.
The first option ensures that the system currently defined in the ADMS interface is used
in the Mapper; the second option allows you to choose the coordinate system from an
extensive list of options.

You should choose a map coordinate system that is compatible with the ADMS
coordinate system.
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@ ADMS Mapper

File Help

et
N Save edits

—

I
=

o]|

<

m|

B v Road sources [0)

K]

ANAN

2 v Area sources (0]

X

EN

E W] Volume sources [0)

&

A

B W Grid source cells [0]

Kl

2

= [w] Output grid extent

Set map coordinate system

Copy map to clipboard

Copy legend to clipboard

Copy scalebar to clipboard
Extract all data from raster layers

Interpolate point data

Use the ADMS-Urban coordinate system

Click ta rotate: feature

A

&z wd-

400

#: 253 E3004 v 271 96672 | Editing: none Scaler 1:15.300

Figure 31 — The coordinate systems options in the Edit menu.

If the Set map coordinate system option is selected then a new window appears, as shown
in Figure 32, where the coordinate system can be chosen from an extensive list of
options. To select a Projected system, click on the radio button and then choose the
system from the drop-down list.

Rather than scrolling through the entire list of options to find your desired choice you
can click in the box and type the name of the coordinate system you wish to use. For
example, to quickly find the Ordnance Survey grid for Great Britain type OSGB. You can
also type part of the name and then click on the drop down arrow to see a shorter list of

options.

Coordinate Systern

{* Projected system:

(]

i~ Geographic system:

==l

|WGS 84 (epsg: 4326)

i~ Turn off {unknown system)

2
Cancel | OK |

Figure 32 — Choice of the coordinate system

A Geographic system can be chosen in a similar way to a Projected system.

If you wish to use the Unspecified regular Cartesian grid from the model interface, i.e. if
the coordinates are site specific, for example distances relative to a source centre, then

the Turn off (unknown system) option must be chosen.
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5.2

5.3

Adding a background map

Background maps can easily be added to the map view window in the Mapper. This is
done using the Add background map button on the toolbar. This uses a WMS link to add a
dynamic layer to the map view. See Section 5.4 for more details.

Step 1 Check that a valid coordinate system has been set for the Mapper. See Section
5.1.
step2  Click on the Add background map button on the toolbar. 4

Step 3 A map layer will be added to the Mapper layer panel.

The map service used for the background map will depend upon the BackgroundMap
setting in the [Mapperinterface] section of the parent model’s configuration file. An
example service is supplied with the model install via a Protocol Layer Connector file
(.ttkwp), but you can change this if you have an alternative WMS you would prefer to
use.

Displaying background images

Background images can be added to the map view window in the Mapper. This is done
using the Add Layer button on the toolbar. The add layer feature allows files with a wide
variety of formats to be loaded into the Mapper.

To load an image to use as a background map, the image must be correctly
georeferenced, which can be done using world files or Maplnfo *.tab files. For British
OS Map data, world files are available from the Ordnance Survey website. These
instructions show how to load an OS map tile as a background map using the
corresponding world file to georeference it.

Step1  Ensure the map tile image file (*.tif) and world file (*.tfw) have the same
name and are in the same directory.

Step2  Check that a valid coordinate system has been set for the background layer.
See Section 5.3.1.

Step3  Inthe Mapper click on the Add Layer button on the toolbar. ¥

Step 4  The Add Layer screen is then displayed, as shown in Figure 33. Browse to find
the *.tif file for the map tile, then click on the Open button.

As an alternative to Steps 3-4, the file can be drag-dropped from Explorer
onto the layer panel.
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55 Add Layer =
@Qvl <« CERC » ADMS-Urb » Data ~ [ 43 || search Data )
Organize v New folder = v [ t@

- Favorites
4 Libraries
1% Computer

‘ﬁ Network

Ss79r.tif

File name: Ss79r.tif v [Tag Image File Format (*.tif;*.til V]

[ Open iv] [ Cancel ]

Figure 33 - The Add Layer screen.

Step 5  The map tile will be added to the map view window. This layer will be at the
top of the Layers tab and will need to be moved down to allow the ADMS
layers to be seen.

5.3.1 Setting the coordinate system for a background layer

To set a coordinate system for a background map you will need to create a *.prj file as
follows. Suppose that the background map you wish to add has the filename map.tif.
Then follow these steps:

Step1  Double click on one of the layers in the layer panel. A new window will
appear.

Step2  Select General from the left panel to view the layer information, as shown in
Figure 34.
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Step 3

Figure 34 — The General section of the layer properties screen

dialogue box shown in Figure 32.

Step 4

Click on the Select button next to the Coordinate System cell to bring up the

Choose the coordinate system you wish to use in the background layer from

the available list and then click on the ellipsis (...). This will bring up the
Coordinate System Setup screen shown in Figure 35.

You must choose a coordinate system that is the same as, or consistent with,

the coordinate systems used for the other layers.

Coordinate System Setup

Jwer |

Ll

SGB_1936_British_Mational_Grid

Projection

Cancel

(=Sl
e |

|Transuerse Mercator {epsg:9807)

Central Meridian Latitude OF Origin

[20'0.00" W | 457 0'0.00" N

False Easting False Morthing

[400000 | [-200000

Scale Factor
09996012717 |

Unit
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=

Geographic System

o

SGB 1936 (epsg:4277)

S|l

Figure 35 — The Coordinate System Setup screen.
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Step5  Click on the WKT tab. The screen will be similar to that shown in Figure 36.

Coordinate Systemn Setup

I Projected System

|

PROJCS[Eritish_Mational_Grid",GEOGCS
[(GCS_0SGE_1936", DATUM[OSGE_1936",SPHEROID
[“airy_18307,6377563. 396,299, 3249646] TOWGSS4[375, -
111,431,0,0,0,0]],PRIMEM["Greenwich”, 0], UNIT
[Tegree”,0.0174532925199433]] ,PROJECTION
["Transverse_Mercator”, AUTHORITY ["EPSG", "9807]] ,PARAMETER
["Central_Meridian®,-2] ,FARAMETER

[Latitude_Of Origin”,49], FPARAMETER
["False_Easting”,400000],PARAMETER [ False_MNorthing”,-
100000] PARAMETER ["Scale_Factor™,0.9996012717], UNIT
[Meter™, 1, AUTHORITY["EPSG", "9001"]] AUTHORITY
[EPSG","277007]

[ Pretty Wkt Import... ‘ Export... |

(58
Cancel

Figure 36 — The WKT tab.

Sstep 6  Click on Export... and save the file in the same location as the map.tif file with
the file stem map.tif and extension .prj, i.e. save the file with name

map.tif.prj.

The same procedure applies to other file types, not just *.tif files. In general
for a file with name <filename>.ext, where .ext is any extension, the name of
the projected file must be <filename>.ext.prj

Step 7 After you have saved the *.prj file click Cancel to close the three sub-screens
that appeared in the process of creating the *.prj file.
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5.4 Adding background map imagery from a Web Map
Service (WMS)

It is possible to add a background map layer in the Mapper from a Web Map Service
(WMS). The background map imagery can help display and locate your data and
results. There are two methods for adding background map imagery: one is to use the
Add WMS layer command from the File menu to specify a URL to a web map service; the
other is to use a special Protocol Layer Connector file (.ttkwp).

5.4.1 Adding background map imagery with the Add WMS layer command

Step 1

Step 2
Step 3

Step 4

First ensure that the coordinate systems in the ADMS interface and the
Mapper are set appropriately for the map that you wish to use. For
example, in the UK the coordinate system for the ADMS interface is often
set to OSGB 1936 British National Grid. (Refer to your relevant model
user guide for full details on how to do this.) In the Mapper the coordinate
system can either be set to use the ADMS coordinate system (i.e. the
coordinate system specified in the ADMS interface), or a particular
coordinate system can be defined (e.g. WGS 84). This is done under the
Edit menu. See Section 5.1 for full details on how to set the coordinate
system in the Mapper. Also ensure that all the coordinates in the interface
are given using the specified coordinate system.

Select the Add WMS layer command from the File menu.

A window appears as shown in Figure 37. Specify the URL for the web
map service and click OK.

-

CERCMapper @
Enter the URL for the "WMS layer

Cancel

Figure 37 — The Add WMS Layer window.

The map will be displayed. The layers may need to be reordered to view
the map and other layers properly (see Section 1.7.4). An example is
shown in Figure 38.
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Save your changes to ADMS-Urban

Figure 38 — Background map imagery in the Mapper; © OpenStreetMap

contributors www.openstreetmap.org/copyright.

For best results, Map layers and data layers should use the same coordinate system.
Some coordinate systems may not be mutually compatible.

5.4.2 Adding background map imagery using a Protocol Layer Connector file

Alternatively a background map may be added by using a Protocol Layer Connector
file as described here. An example file is included in your ADMS install directory: this

links to the OpenStreetMap WMS.

Step 1

relevant model user guide and Section 5.1 of this user guide).

Step 2
Step 3

Click on the Add Layer tool ¥ .

Navigate to the directory containing your *.ttkwp file. Select Files of type:
Protocol Layer Connector (*.ttkwp) to display the files:

Ensure that the coordinate systems in the ADMS interface and the Mapper
are set appropriately for the map that you wish to use. (Refer to the
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@ Add Layer @
@@v| . v Computer » Local Disk (D:) » Example v|¢,|| Search Example o
Organize = Mew folder ==« IZ:@}ZI
» 9 Favorites Name Date Type

|| OpenStreetMaps Global TMS.ttkwp 20,/08,/2014 00:00 TTKW
* |l Libraries
> /M Computer
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File name: OpenStreetMaps Global TMS.ttkwp - | Protocol Layer Connector (*.ttk v|
[ Open |vl | Cancel |

Figure 39 — Selecting Protocol Layer Connector files.

Step 4 Select a (*.ttkwp) file that covers the geographic location of your sources
and click Open.

As an alternative to Steps 2-4, the file can be drag-dropped from Explorer
onto the layer panel.

Step 5 The new layer will be displayed in the Mapper. By default, the view is
zoomed to the full extent of the new layer (Figure 40). The layers may
need to be reordered so that the background image does not obscure the
view of the other layers. Information on reordering layers can be found in

Section 1.7.4.

Contact the CERC helpdesk for help setting up *.ttkwp files for other

maps.
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Figure 40 — New layer in the Mapper; © OpenStreetMap contributors
www.openstreetmap.org/copyright.

Step 6 Select the output grid extent or largest source layer and select Zoom to
Iayer?i.

Step 7 This will zoom to the correct location on the map (Figure 41).
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Figure 41 — Background image displayed in the Mapper; © OpenStreetMap
contributors www.openstreetmap.org/copyright.

For best results, Map layers and data layers should use the same coordinate
system. Some coordinate systems may not be mutually compatible.
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5.5 Displaying data layers

Data from external files can be displayed in the Mapper using the Add layer toolbar
button. Recognised formats such as ESRI shape files (.shp) and MapInfo Interchange
Format files (.mif) will be displayed automatically, but generic delimited data files such
as comma separated variables (.csv) will first prompt you to define data fields as well as
selecting the data that you wish to display.

Data layers created from files are not editable, but their appearance can be modified as
outlined in Section 4.

5.5.1 Using drag and drop

When you are selecting data files to add to the Mapper you can click on the Add layer
tool ¥, and browse to the file.

Alternatively you can locate the file that you wish to add to the Mapper in Windows
Explorer, click and drag it to the layer panel of Mapper. If the file is a recognised
format it will then be added immediately, otherwise further steps need to be followed
as detailed in Section 5.5.3.

5.5.2 Data from recognised file formats

If you choose Add layer and select a file in a recognised format, such as an ESRI shape
file (.shp), the Mapper will automatically display it in the map as a new layer.

This applies to all supported vector files; see Appendix A.3 for a list of recognised file
types. For pixel (image) or grid files, see Section 5.2.

Step1  Click on the Add Layer tool ¥ . A new window will appear as shown in Figure
42.
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B Add Loyer =
®v| .. » Computer » Local Disk (D:) » Example - | 4,.| Search Example pe |
Organize » Mew folder =~ 0l @

i Favorites MName Date Type

Mo items match your search.
= Libraries

1M Com puter

“! MNetwork

< 1 ] 3

File name: map.tif - ’Commonfil5 v]

| Open |v| ’ Cancel ]

Figure 42 — Add Layer window.

Step 2 Change the file type from Common files to ArcView Shape Files (*.shp).

Step 3 Navigate to the file you wish to view and click Open. The data will then be
displayed in the Mapper as shown in Figure 43.

As an alternative to Steps 1-3 you can use drag and drop.
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2 :;% .

1 [w] building_h_filmissing® ﬂ f;‘ﬁ :}“‘ k&‘\ ‘ ?‘3 (f
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Figure 43 — Data from the shape file displayed in the Mapper.

Sstep 4  Information about the data can then be viewed. Select the information tool @
and click on one of the shapes. (Full details on the information tool can be
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found in Section 5.7). Information is then displayed in the Attributes table, as
shown in Figure 44. The information available will depend on the file type
and the file data.

It is possible to colour and label shapes according to their properties. See
Sections 4.6 and 4.7 for further details.
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ADME-Lrban isw e gy e < %??«,
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Figure 44 — Information from the numerical data displayed in the Mapper.

5.5.3 Data from CSV and other delimited text files

If you di
to load i

splay data from a CSV file or unrecognised text file, the Mapper will attempt
t into a layer, providing an intermediary window for selecting data from the

file. If the file contains a header line, the Mapper will attempt to find it and identify

the start

of the data lines; otherwise you need to manually enter the column headers.

Data can be displayed as points, polylines or polygons but must be identified as such
in the column headers by following a specific naming convention, while all other

columns

are treated as properties. In each case this can be done in the file or in the

Mapper data window:

*  For

point layers, there must be an easting and a northing named appropriately in

order to display the data.

*

*

*

The easting must be named as one of X, X(m), or X (m)
The northing must be named as one of Y, Y(m), or Y (m)

The elevation will be recognised if it is one of Z, Z(m), Z (m), or
ELEVATION. Elevation can also be set to any column by right clicking
the column header and selecting Set as elevation field. To clear, right click
on the elevation field again and select Clear elevation field.
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@ Select data to use in layer: Example.plt = @
File: D:\ExampleshExample.plt Lines: 3

Start line: |2 End line: |3 [V End of file Delimiter: |. Reload
Receptar name Hm] *'Im] Z[m] Conclug/m3ND skl sources: | | F -

# Feceptar name | *(m] *[m] Z[m) Conclug/maMr———" e Ton oo

1 Receptor name  |#[m) '[m] Z[m] Conclug/m3M Set as elevation field | |

2 School 500.00 25000 0.00 0.227885E +( oo

3 Playing fields 285.00 900.00 0.00 0.000000E +0
] »

0 Gotoline | Convert data to grid using: Matural Meighbour + Ok | Cancel

Figure 45 — Setting the Elevation field in the Mapper.

*  For polyline layers, at least two appropriately named vertices must be supplied in
order to display the data.

*  For the start point, the easting must be named as X1 and the northing must
be named as Y1
*  For the next point, they must be named as X2 and Y2 respectively

*  Subsequent points can be provided, continuing the naming sequence. For
each point both X and Y must be provided and they must form a
continuous sequence starting from 1.

*  The elevation must be named as one of Z, Z(m), Z (m), or ELEVATION
*  For polygon layers, at least three appropriately named vertices must be supplied in
order to display the data.
*  For the start point, the easting must be named as pX1 and the northing
must be named as pY'1
*  For the next point, they must be named as pX2 and pY2 respectively
*  For the next point, they must be named as pX3 and pY3 respectively

*  Subsequent points can be provided, continuing the naming sequence. For
each point both pX and pY must be provided and they must form a
continuous sequence starting from 1.

The polygon will be closed automatically, so the first and last vertices must be
in different locations.

*  The elevation must be named as one of Z, Z(m), Z (m), or ELEVATION

The data window — shown in Figure 46 — has the following options for data selection:

*  The option to enter the Start line and End line (or select End of file). The delimiter
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can also be entered.

*  An editable header line (yellow background) lets you choose which columns are
included as properties in the layer. Columns that have ‘-> or whitespace for their
header not included as layer properties.

* A right-click menu on the # column that has the following options:
*  Set as first data line — selects a new data start line.
*  Set as last data line — choose a new data end line.

*  Copy to header — replaces the contents of the editable header line with the
selected line.

*  Go to line button — Brings the line specified in the box to its left into view in the
table.

*  Reload button — Refreshes the table

*  Convert data to grid using: — check this option at the bottom of the data window if
you require a *.grd file of your data. Once the selection box has been checked,
set the grid field by right clicking the mouse over the relevant column of data.
Then press the OK button.

@Select data to use in layer: Example.gst = @

File: D:%Examples\Example.gst Lines: 2884

Start line: |2 Endline: |2854 ¥ End of file Delirniter: |, Reload

‘Year Day Howr Tirnefs] <m) *im] Z[m] Conclug/m3]| -
# 'ear Day Hour Time(z) #m] “f[m] Z[m] Conclug/m3ll
1 Year Ciay Hour Time(z] ) *[rm) Zlm) Conclug/m3ll
2 2019 1 12 -993 -1000.00 -1000.00 0.00 0.000000E 4
3 2019 1 12 993 93333 -1000.00 0.00 0.000000E 4
4 2019 1 12 -933 -866.67 -1000.00 0.00 0.000000E 4
L] 2019 1 12 -993 -800.00 -1000.00 0.00 0.000000E 4
[ 2019 1 12 993 73333 -1000.00 0.00 0.000000E 4
7 2019 1 12 933 -BEE.EF -1000.00 0.00 0.000000E 4
8 2019 1 12 -993 -600.00 -1000.00 0.00 0.000000E 4
a9 2019 1 12 -993 -533.33 -1000.00 0.00 0.000000E 4
10 2019 1 12 993 -4EE.ET -1000.00 0.00 0.000000E 4
11 oo - 12 -933 -400.00 -1000.00 0.00 0.000000E 4
12| Set as first data line 7 339 33333 | -1000.00 0.00 | 0.000000E-
13 | Set as last data line 2 993 -2BE.E7 -1000.00 0.00 0.000000E 4
14 2 993 -200.00 -1000.00 0.00 0.000000E 4
15 | Eopaioiheadey 7 559 43333 | -000.00 0.00 | 0.000000E
16 2019 1 12 -993 -BE.E7 -1000.00 0.00 0.000000E 4
17 2019 1 12 -939 -0.00 -1000.00 0.00 0.000000E 4
18 2019 1 12 -933 BE.E7 -1000.00 0.00 0.000000E 4
19 2019 1 12 -993 133.33 -1000.00 0.00 0.000000E 4
20 2019 1 12 999 200.000 -1000.00 0.00 0.000000E 4 -
4 »
0 Gota line [~ Convert data to grid uzsing: Matural Neighbour K Cancel

Figure 46 — Data window

Suppose that you wish to display data from a tunnel file Tunnels.csv alongside data in
Example6b.upl (these examples files are not supplied with ADMS 6). Ensure that the
UPL file is loaded and follow these steps:

step1  Click on the Add Layer tool¥. A new window will appear as shown in
Figure 47.
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@Add Layer @
@Uv| . v Computer » Local Disk (D) » Example - | ¢¢|| Search Example p'
Organize = Mew folder ==« 0l @
r Favorites MName Date Type

Mo items match your search.
= Libraries
1M Computer
gl_-l Metwork
'l 1 3
File name: map.tif - ICommon files v‘
[ Open |vl I Cancel ‘

Figure 47 — Add Layer window.

Step 2  Change the file type from Common files to All Vector Files.
Step 3 Navigate to the *.csv file you wish to view and click Open. A new window
will appear as shown in Figure 48.
@Select data to use in layer: Tunnels.csv = @
File: D:\EsxampleshT unnels.cav Lines: 4
Start line: 3 End line: [4 ¥ End of file Delmiter: . Reload
Mame =1 1 e 2 MumTrafficDi| BoreDepthl | PortalB azeEl| Outflowk .
# [ amne 1 1 2 W2 MHurnTrafficDi| BoreDepthl | PaortalB azeE hf Outflawk
1 FoadTunnef
2 Mame 1 Ad! e e MumTrafficDi| BoreDepthl |PortalB azeE b| Outflowk
3 Chesterton B|545326.67 | 25548053  |544606 253056 1 -1 -1 rione
4 M agdalene 5| 544606 269056 544788 258880 2 4 1] Castle S
4 » :
] Gotoline | Conwert data ta grid using: Natural Meighbour ~ ok Cancel
Figure 48 — Data from Tunnels.csv
Step 4  This window can be used to select which data you wish to display in the
Mapper. See Section 3.4 for an example that requires data selection.
Step 5  Once you have selected the data that you wish to display click OK. The data

will then be displayed in the Mapper as shown in Figure 49. The default line

appearance is a thin black line.
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Figure 49 — Data from the tunnels.csv file displayed in the Mapper.

Step 6  Information about the data can then be viewed. Ensure that the data layer is
selected in the layer panel. Select the information tool @ and click on one of
the data points. (Full details on the information tool can be found in Section
5.7). Information is then displayed in the Attributes table, as shown in Figure
50. The information includes all of the columns shown in the data window.

It is possible to colour the data according to its properties. See Section 4.6

for further details.
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Figure 50 — Information from the tunnels.csv file displayed in the Mapper.
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5.6 Extract data tool

If a raster layer has been added to the Mapper, it is possible to extract the data from this
layer into *.csv format. This can be achieved through a simple process, although there
are more advanced options to satisfy precise requirements for the output data.

5.6.1 Using the Extract data tool
This can be done by following these instructions.

Step 1  Add the raster data file to the Mapper. In this example, an OS terrain 50 file
will be added, and a section of the terrain data extracted for use with ADMS.

@ADMS Mapper
File Edit Help

LI9¥FRBL/BRAAGD e »(Oad| - -AMARNSOC|EL(OD-
Layers I Grouping 3D
B[V 1052 ﬂ

=)

B [V Paint sources (0)
®
B[] Line sources (0)

B[] Road sources (0)

B [V] Area sources (0]

B [V] Volume sources (0]

2000

‘ Delete the currently selected feature

| X:5.5417804E+05 : 1.30500E +05 | Editing: none iScaIe: 176700

Figure 51 — Mapper showing an OS terrain 50 file, which has been coloured by
terrain height.

Step2  Press the button Extract data from raster layers,Z3, to bring up the Extract data

screen. Alternatively, you can select the Extract data from raster layers option
from the Edit menu.

Step 3  The Extract Data Extent is now displayed in the map as a new layer. By
default, it covers the whole of the current map view window. If you wish to
change the extent, you can redefine, move or edit it using the standard

Mapper editing tools (see below). Alternatively, you can edit the extent
manually in the Extract data screen.
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Edit Help
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Figure 52 — Mapper showing the Extract Data Extent as a red rectangle.

Sstep 4  Check the selected data layers and customise output data options if necessary;
see Section 5.6.5 for a description of the available options.
Extract data
 Layers
TUs2 v 1 155.87 120,45 - a Golden Software Surfer ASCH Grid Farme
— Dutput col — Dutput extent
v ‘white header ¥ Inchude index column All
= i " _ Min (1] [44156 Min'r [ [258432
[4] I+ Man [ 545835 Man'Y | [253757
(U“tl’“‘ type KEwent| 1739 | YEwent| 135 |
i+ Data " RGB ‘
— Output gpacing
Coordinate syst
[Map - UNKN DWN (epsg:0) | x (| [E7or7I7ITRL v (3| [5-739153885¢
~Missing data % sz | V()| B7Me154 |
[~ Add values for missing data points Faints in| = | Faints in | 1% |
Default data value| ID Total points| 43920 |
Fefresh | Create | Cloze I
|La_l,ler hame Hin: | M a: |
Figure 53 — Extract data screen
Step 5

When you have confirmed all the settings are as you desire, click Create. You
will be prompted to enter the name of the output file. Once the file has been

successfully created, a notification dialog will inform you of the number of
points written to the file.
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Step 6

- ™

Extraction complete

I’Ol Successfully extracted 49784 points

........................................

Figure 54 — Notification of successful data extraction

If you have been making changes in both the Mapper and the Extract data
screen and you want to ensure they are synchronised before continuing, you
can click the Refresh button.

The resulting output *.csv file can be added to the Mapper or viewed in a text
editor (e.g. Notepad) or spreadsheet package (e.g. Microsoft Excel).

5.6.2 Redefining the Extract Data Extent

Step 1
Step 2
Step 3

Step 4

Select the Extract Data Extent layer from the layer panel.
Click on the Add Feature button on the toolbar to select it. L

Click on the location of one corner of the extent in the map view window, and
while holding down the mouse button, move the cursor to draw the extent
required before releasing the mouse button.

A new extent has been defined and the Output extent section of the Extract data
screen will have been updated automatically to show its new coordinates.
These coordinates can now be manually adjusted further if desired.

5.6.3 Editing the Extract Data Extent

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Extract Data Extent layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. «-I

Click anywhere within the current extent. Three of the extent vertices will
appear as green dots and the fourth vertex as a red dot.

The vertex with the red dot indicates which corner of the extent will be
movable. To select a different vertex, use either the full stop (.) or comma (,)
keys on the keyboard.

Click in the map window, and while holding down the mouse button, move
the cursor until the red grid vertex is in the desired location before releasing
the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the Extract
data screen. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.
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5.6.4 Moving the Extract Data Extent

Step 1
Step 2
Step 3

Step 4

Select the Extract Data Extent layer from the layer panel.
Click on the Shift Feature button on the toolbar to select it. £3

Click anywhere within the current extent, and while holding down the mouse
button, move the cursor to the new location for the extent before releasing the
mouse button.

Click on the Save Edits button on the toolbar to save the changes to the Extract
data screen. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

5.6.5 Extract data options

There are a range of options that can be used to customise the extraction of data
including altering the location, spacing and coordinate system.

*

Basic options:

*  Choose which Layers to extract data from. Layers that overlap the selected
area are included by default. In general, layers with a single data band (e.g.
OS terrain data) and layers with multiple data bands (i.e. Red-Green-Blue
raster data) should not be included at the same time.

*  Choose whether or not to write a header row to the data file by selecting or
deselecting the relevant checkbox. If you choose to write a header row, the
column headings can be edited.

= Select whether or not to include an index column.

When creating an ADMS format terrain file, it should not have a header row,
but an index column should be included.

*  Select whether to extract the data with a single band (e.g. elevations) or with
multiple bands (e.g. RGB values).

*  The Output spacing should be set to the required resolution in the X and Y
directions. You can specify a different spacing in each direction if required.
The maximum number of output points is 500,000. If the output spacing
entered would result in more than this number of output points it is
automatically reset to the nearest value that reduces the number to within
tolerance.

Additional options:

*  The Coordinate system for the output data can be selected. By default this is
set to the ADMS coordinate system, but it can be changed to match the
raster layer or map coordinate systems.

When creating an ADMS format terrain file, the coordinate system should
match the ADMS model data that it will be used with.

* It is also possible to manually edit the Output extent in the Extract data screen
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if you wish to change the selected range of X and Y coordinates. To do this,
type in the Min X, Max X, Min Y and Max Y values in the boxes provided. This
will automatically update the Extract Data Extent layer in the map view
window.

*  Some layers can have regions with no data; you can specify the value to be
entered in these regions, e.g. some formats of terrain data files do not report
values over areas of sea, and in this case the terrain height should be set to
zero.
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5.7 Information about a feature

The Mapper allows you to view information about a model feature or a raster layer from
within the Mapper. To display the information about a model feature, follow these
instructions.

Sstep1  Click on the Information button on the toolbar. @

Step 2 Then click on the feature in the map view window.

Step 3 Information will be displayed about the feature in the attributes table, as
shown in Figure 55.
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Figure 55 — The feature information screen for a point source.

Step 4  Click on the model name button (e.g. ADMS) to be directed to the feature in
the model.

step 5  Click on the View button for the feature to be highlighted in the Mapper.

Holding down AltGr ensures that only features in the currently selected layer can be
clicked.

To display information about a raster layer containing data values, including any
contour plots created with the 2D output plotter, follow these instructions:

Step 1  Ensure that the raster layer is selected in the layer panel

Step 2  Click on the Information button on the toolbar. @

Step 3 As you move the cursor across the raster layer, the value at that point will be
displayed on the right hand side of the status bar, as shown in Figure 56.
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Step 4  Hold down AltGr and click on the raster layer to display the value and X, Y
coordinates at that particular location in the attributes table, also shown in

Figure 56.
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Figure 56 — The feature information screen for a raster layer.
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5.8 Measuring distances

The Mapper comes with a tool that allows you to measure the distance between two or
more points in the map view window. Follow these instructions to measure distances in
the map view window.

step1  Click on the Measure button on the toolbar. &

Sstep 2  Click on the map view window at the first point of interest, and then click on
a second point. A dotted line is produced between the two points of interest
and the distance between the two points is shown on the status bar in the
bottom left hand corner of the Mapper window, as shown in Figure 57.
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Figure 57 — Measuring distances in the Mapper. The distance is given in the bottom
left corner.

step 3  Clicking on further points adds further lines and the cumulative distance is
displayed in the status bar.

Step 4  The position of the points can be modified as follows:

e To add a point, click on the existing point that lies before the desired location
of the new point and then click where you want the new point to be.

e To move a point, click on the point, and while holding down the mouse button,
move the cursor to the new location for the point before releasing the mouse
button.

e To delete a point, first click on the point to select it, and then click on it again.

The points that the distance is being measured between appear as coloured
squares. The current selected point is red and the other points are green.

Step 5  Toremove all the defined points whilst using the measuring tool, double click
anywhere in the map view window.
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5.9 Displaying the north arrow

It is possible to toggle the display of an arrow in the Mapper that indicates the direction
of north, see Figure 58 . The north arrow is only displayed when the plot is in 2D mode.

% ADMS Mapper
Edit Help
Mew project
Open project...
Save project
Save project as...
Add layer
Add WMS layer
Rermove layer
Export layer...
Save all layer settings
Restore factory settings

Preferences

Print...

Close

1 D\Bamples\Building.mpj

S T g sas

[ [w] Output points [361]
+

RGO« »|@a0

3 Snap to shape
v Display north arrow
Gridding option 3

Click to export the cunently selected laver

& wd-

. -1378.0443 . 2B0.0738 | Editing: none

=N e =)

400

Scale: 1:15.300

Figure 58 — The north arrow is displayed in the top right hand corner of the map window.

To toggle the north arrow select/deselect File > Preferences > Display north arrow as desired.
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5.10 Viewing features in 3D

5.10.

Features in the Mapper can be viewed in 3D. This can be especially helpful when
checking building or source heights, or when examining complex terrain, variable
roughness or concentration fields.

To see a 3D visualisation of the features in the Mapper first click on the Change View
icon™. After doing this, the map view will change and the Change View icon will also
change. To return to the 2D planar view, click again on the new Change View iconl=.

When in 3D mode, three axes are shown: vertical (blue), east-west (red) and north-south
(green). By clicking and holding the mouse you can rotate the map to examine the 3D
visualisation from various points of view. A new button appears which enables you to
change the method of panning the camera — the options available are summarised in
Table 4.

See for example Figure 59 which shows a view of buildings in the Mapper when in
standard mode and when in 3D mode.

ADMS Mapper o | | B AoMs Mapper o8 ==
[

e Edt belp e fdt e
LR BTL/AURQAF D+ Bad a-maORG EZed- L e%t By
T "

Figure 59 — Buildings viewed in 2D and 3D modes.

Some layers will have both a height (Z) and a depth (M), for example a building can
be at a terrain height Z, with a depth of M.

The vertical scale can be exaggerated using the Scale Z (%) and Scale M (%) options in the
3D tab. This may be required for clarity if the horizontal extent of the modelling region
is much larger than the vertical extent of the buildings, sources, terrain, etc.

1 Options in the 3D panel

When in 3D mode the view can also be changed a variety of ways by using the options
under the 3D tab in the layer panel.

e Vertical, Horizontal and Distance — allows manual setting of the position of the
camera in spherical coordinates. The + and - buttons change the distance of the
camera from the origin of the X,Y,Z axis.
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e Reference point — positions the origin along the Z axis (altitude) relative to the
layers shown:

e Base — if there is at least one layer which is a digital elevation model
(DEM), then the base is set to the lowest Z value found in the DEM

e Zero — the value is set to zero regardless of the Z coordinates found in the
open layers

e Lowest — lowest value of all Z coordinates in all the layers
e Highest - highest value of all Z coordinates in all the layers

e  On DEM - the value of the Z coordinate read from the DEM at the longitude
and latitude of the origin pointer; this does not change if the origin pointer
changes

e Fly on DEM — as On DEM, but the value updates if the position of the origin
pointer changes

e Lights — toggles the directional light on/off

e Shadows — sets the intensity of shadows when the directional light is turned on;
varies from 0 (no shadows) to 100 (darkest shadows)

e Base plane — toggles a base plane on/off
e  Wireframe — toggles the wireframe display mode on/off
e Edges — toggles edges on/off on the 3D objects

e Scale Z (%) — scales the height (Z) coordinate of all open layers; 100 is the actual
size

e Scale M (%) — scales the depth (M) coordinate of all open layers; 100 is the
actual size

e  Flood — toggles on/off a floodplains simulation; the numerical value is the flood
level (in metres)

e Wall - if there is at least one digital elevation model (DEM) among the open
layers, this option sets the appearance of the DEM boundaries:

e Off —no DEM walls
e  Colour — grey walls with contour lines

e Texture — textured walls with contour lines
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5.11 Copying the map view window to the clipboard

To copy the current view from the map view window select Copy map to clipboard from
the Edit menu. This image can then be pasted into a document or picture editing
software and saved.

The Copy legend to clipboard option from the Edit menu can be used to copy an image of
the layer panel to the clipboard. If only a part of the layer panel is required, for instance
the legend for a contour plot, then the image should be pasted into image processing
software and then cut down as appropriate.

The Attributes section of the layer panel is not copied to the clipboard.

The Copy scalebar to clipboard option from the Edit menu can be used to copy an image of
the scalebar to the clipboard.

5.12 Export features

The Mapper layers can be exported to a variety of formats. Some popular formats
available are

e ArcView Shape Files (*.shp)

e Autocad (*.dxf)

¢ Digital Line Graphs (*.opt) — line sources only

e Geographic Markup Language (*.gml)

e GPS Exchange Format (*.gpx)

e Keyhole Markup Language (*.kml)

e Maplinfo Interchange (*.mif)

To export a layer into any of these formats first click on the layer in the layer panel to
select it. Then click on the Export Layer button on the toolbar ¥. This brings up the
export layer screen, as shown in Figure 60. Select the file type you wish to export to,
give the file a name then click on the Save button.
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File name:

@ Save Layer @
@uvl v Computer » Local Disk (D:) » Example - |v&,| | Search Example 2|
Organize = Mew folder = = '9‘
't Favorites MName Date Type

No items match your search,
o Libraries
'8 Computer
G‘I_-I Metwork

Save as type: | ArcView Shape Files (*.shp)

e |

“ Hide Folders [

Save

| |

Cancel |

Figure 60 - The Export Layer window.

Alternatively a layer can be exported by selecting it and then right-clicking to display
the menu. Select Export layer and then select the file type from the sub-menu which
offers four formats, to SHP...., to KML...., to CSV... and for SPT....

With the first three of these options, a new window will

appear which you can use to

save the file in your desired location. The file type will be selected automatically and a
default name for the file is suggested, based on the name of the layer.

The for SPT... option opens a series of forms that automate the generation of comma-
separated .spt (and related) files that can be imported directly into the ADMS models.

See Section 5.12.2 below for more details.
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File

@ADMS Mapper
Edit Help
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Settings v
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Simplify layer
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Statistics

Deselect layer

Remove layer

\ | -
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»-138.21033 ¥ 73.874539 | Editing: none Scale: 1:1.530

Figure 61 - The Export Layer right-click option.

5.12.1 Exporting to Google Earth

The layers can be exported so that they can be viewed in Google Earth. This may be
useful for checking the locations of sources and buildings etc. against a satellite image
of the area being modelled. To do this, follow these steps:

Step 1
Step 2

Step 3

Step 4

Set the coordinate system for the map, see Section 5.1.

Ensure that a valid projected or geographic coordinate system has been set
for the layers that are being exported. Refer to Section 5.2 for details on
how to do this.

The coordinate systems for the ADMS layers do not need to be changed in
the Mapper. These are set automatically from the option defined in the
ADMS interface. The Unspecified regular Cartesian grid cannot be used if you
wish to export an ADMS layer to Google Earth.

Export the layer to Keyhole Markup Language (*.kml) by following the
instructions given above.

Open the *.kml file in Google Earth.

5.12.2 Exporting for SPT

Non-ADMS layers containing source information, e.g. a shape file of point or road
source data, can be exported for .spt format so that they can be easily imported into the
relevant ADMS model for inclusion in the dispersion calculations. Once imported, the
sources will appear in the relevant ADMS source layer in the Mapper; the original
non-ADMS layer can then be removed/unticked to avoid duplicating the visualisation
of these sources.
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To do this, follow these steps:

Sstep 1  Right-click on the relevant non-ADMS layer in the layer panel and select
Export layer > for SPT.... This brings up the Export files for SPT form, as shown

in Figure 62.
5 Export files for SPT (==5a]
Al fields ~|  Source name field Mame | Traffic dataset
[Drensity] - bl [lle. p .
[Depth] Lge WaR file? - Width/depth
{E;:;n;itoeg] Specific heat capacity Canyon height
{E’gg:ﬂ'ﬂﬁ;}iw Molecular mazs ’— Angle of elevation l—
{%e]ometrle] = Bunoyancy type - Horizontal angle
H:f-‘rfeg icing] Buoyancy value ‘Wwiater ratio
ainB uilding
maﬂr;e[];* , Actual or NTP? | Traffic flows used? =
g/s
[MO= [9/%]] Efflux type - Traffic pear
[Temperatuns]
[Wertices] i Efflx value Foad type
Tl irne i ratel
m Heat release rate Gradient
#50 L
{Areal Source ype = M.ain building -
%E;‘ZEE}} Height Comments
iLengthCS} Diameter
Export | Cloze |

Figure 62 — Export files for SPT, SPT file section

Step 2 Using the drop-down menu next to Source name field, select which of the
fields in the non-ADMS layer contains the source names.

Step 3  If exporting road source data with emissions calculated using traffic flows,
specify name of the Traffic dataset, c.g. “UK EFT v11.0 (2 VC)” — this
should exactly match one of the traffic datasets used in ADMS-
Urban/ADMS-Roads. If exporting data for a different source type, or road
traffic emissions will be user-defined, this box can be left blank.

Step 4  Fill in as much of the SPT file section (source properties) as possible. Boxes
can be filled either by using the drop-down menu (where applicable),
typing directly into the box or drag-dropping the name of a field from the
current layer from the list of fields on the left-hand side of the form
(enclosed in square brackets, e.g. ‘[vame]’) into the relevant box. Field
names will automatically be converted to the relevant values for each
source in the layer upon export. Entering a constant value in a box will
result in every source taking that value for that source property in the .spt
file. Fields that are not relevant/required can be left blank (or filled with
‘na’ or ‘n/a’). Fields that are required in the .spt file for successful import
into the ADMS model but that don’t have an equivalent field in the current
layer can also be left blank, however this information will need to be
manually added to the .spt file after creation before it can be imported into
the ADMS model.

Step 5 Press Next > to move onto the EIT file section (pollutant emissions), as
shown in Figure 63. If the current layer does not contain direct emissions
data, skip to Step 7.
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5 Export files for SPT |

Al fields v | Source name field Name w|  Traffic dataset

[Densiy] EIT file
[D:Qtsl':]y Ernigsion fields Pollutant name

[Diameter]
[Elevation]
[Exit welocity]
[Geometry]
[GeometylD]
[I0]

[Laver]
[MainBuilding]
[Mame]

[NOZ [g/s]]
[NOx [g/s]]
[Temperature]
[Wertices]
Pfnlirne e rakal
#1

H#0

m

threal Emigzion factar
{hrealS}
{Length} Pallutant narme

{LengthCS} '—

< Previous |

Export | Cloze |

Figure 63 — Export files for SPT, EIT file section

Step 6 Fill in as much of the EIT file section as possible in a similar manner. Note
that the Emission fields box can only be filled by drag-dropping field names,
the Pollutant name box can only be filled by typing and the Emission factor
box can also be filled by drag-dropping the name of a parameter associated
with the current layer from the list of parameters (enclosed in curly
brackets, e.g. ‘{Length}’) on the left-hand side of the form. The Pollutant
name box should be used to ensure that the pollutant name associated with
a particular emission field matches a pollutant name as defined in the
ADMS model’s pollutant palette The Emission factor box can be used if
emission data in the current layer are not in the appropriate units. For
example, area source emissions should be given in g/m?%/s in the ADMS
models, so if the current layer contains area source emission rates in g/s, it
would be necessary to multiply the emission field by the area of each
source, i.e. specify ‘/{Area}’ in the Emission factor box.

Step 7 Press Next > to move onto the TFT file section (traffic flows), as shown in. If
the current layer does not contain traffic flow data, skip to Step 9.

&5 Export files for SPT ==

Al fields | Source name field Mame |  Traffic dataset .

[Denszity] - TFT file . . e .
[Depth] Wehicle count figlds Average speed fields Percent uphil fields Wehicle category name

[Diameter]
[Elevation]

[E it welocity]
[Geometry]
[Geometryl D]

[Io]

[Layer]

[t ainBuilding]
[Mame]

[HBZ [g/5]]

[N [g/5]]
[Temperature]
[Vertices]
Tl Pl rake]
#1

#50

{Area) Wehicle count factor |
{freals) )
{Lenath} Wehicle speed factar [ Yehicle category name
{LengthCS}

m

Percent uphil factar | |

< Previous | | E xport | Cloze

Figure 64 — Export files for SPT, TFT file section
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Step 8 Fill in as much of the TFT file section as possible in a similar manner. The
Vehicle category name box should be used to ensure that the vehicle category
name associated with a particular vehicle count field matches a vehicle
category name as defined in the ADMS-Urban/ADMS-Roads interface.
The ‘#1° parameter can be used with the Average speed fields and/or Percent
uphill fields box to indicate a constant value. The constant value itself
should be entered into the Vehicle speed factor/Percent uphill factor box. The
‘#50° parameter is there as a convenience for use with the Percent uphill
fields box (50% implies flat-road emission factors will be used throughout).
The Vehicle count factor, Vehicle speed factor and Percent uphill factor boxes
can be used to apply any appropriate conversions to the data in the current
layer. For example, vehicle speeds should be given in km/hr in the ADMS-
Urban/ADMS-Roads interface, so if the vehicle speed data in the current
layer are in mph, a value of 1.61 should be specified in the Vehicle speed
factor box.

Step 9 Press Export to bring up a Save As window. Browse to where you want the
files to be saved, give them a name (common stem), then click on the Save
button. This will generate up to four files: an .spt file (containing source
properties), a .vgt file (vertex information), an .eit file (pollutant
emissions) and a .tft file (traffic flows).

Step 10 (optional) These files can then be modified further in a text editor (e.g.
Notepad) or spreadsheet package (e.g. Microsoft Excel), if required, before
being imported into the ADMS model via the File > Import menu item from
the model interface; see the relevant model user guide for full details on
importing sources from .spt files.

Step 11 (optional) Once the sources have been imported into the model interface
and the Mapper has been refreshed, it may be desirable to remove/untick
the original non-ADMS layer to avoid duplicating the visualisation of
these sources.
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5.13 Clip layer to polygons

The Clip layer to polygons tool allows individual features from one layer to be ‘clipped’ to
the features from a separate layer, i.e. retained/removed depending on whether they fall
inside or outside the spatial boundaries of the second set of features. The resulting set of
clipped features are saved to a new shape file rather than replacing the original layer. If
clipping zero-dimensional features, e.g. output points, there is also an option to save the
clipped data to an .asp file, which can then be used in an ADMS model run. It is
possible to clip onto any layer that contains polygons or polylines.

To use this tool, follow these steps:

Step 1 Right-click on the layer that you wish to clip, e.g. the Line sources layer, and
select Clip layer to polygons. This brings up the Clip from: form, as shown in
Figure 65.

Step2  Select which layer to clip to using the drop-down menu
Step 3 Select from one of the following Clipping options:

e Wholly inside: Any feature that falls completely inside one of the features
being clipped to will be retained.

¢ Inside including partly outside: Any feature that falls at least partly inside
one of the features being clipped to will be retained. This option is not
available if clipping zero-dimensional features, e.g. point or jet sources.

e Wholly outside: Any feature that falls completely outside all of the features
being clipped to will be retained.

e Outside including partly inside: Any feature that falls at least partly outside
one of the features (and not wholly inside any of the features) being
clipped to will be retained. This option is not available if clipping zero-
dimensional features, e.g. point or jet sources.

?} Clip from: Line sources @

Clip to:

Clipping options

* wWholly inzide

T Inside including partly outside
" Whally outside

" Dutside including partly inside

Output options
% Create shape file
o

1 arne; | Hame J

Z |Elevation J

ar | Canhcel |

Figure 65 — Clip layer to polygons
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The Count in the Clip to: section shows how many features will be retained
with the current clipping option. The map view window will also interactively
show which features will be retained as different clipping options are
selected.

Step 4  In the Output options section, select how the clipped features should be saved
by choosing either Create shape file or (if clipping zero-dimensional features)
Create ASP file. For the latter option, you should also use the Name and Z drop-
down menus to specify which of the fields in the layer being clipped contain
the specified point names and heights, respectively.

Step 5  Press OK to create the output file. If Create shape file was selected, the resulting
shape file will automatically be added as a new layer in the Mapper, and the
original layer being clipped will be unticked.
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5.14 Layer statistics

Statistics about a particular layer can be viewed using the Layer statistics tool. Namely,
the minimum, maximum and X, Y location of each are reported for each numerical field
in the layer. Up to five filters can also be applied to the layer to constrain the number of
features/data points on which to calculate the statistics.

To view the statistics for a particular layer, right click on that layer in the layer panel of
the Mapper and select Statistics. This brings up the Display statistics screen, as shown in

Figure 66.
@ Display statistics: Examplel (961) EI@
Filters
|None j = |None J
|N0ne ﬂ = |N0ne J
|N0ne j = |N0ne J
|None ﬂ = |None J
|N0ne ﬂ = |N0ne J
Copy |
Field Mirirnuam [% Y [GERT [ A -
p [GeometylD Tal I | [roultiple] [multiple] 1 B [rouiltiple] [multiple]
Yertices 41 | [roultiple] [multiple] 1 B [rouiltiple] [multipl=]
Elewation (T L | [roultiple] [multiple] a B [rouiltiple] [multiple]
Depth | U | [multiple] [mwaltiple] ] ) [multipl=] [mwaltiple]
“width [T L | [roultiple] [multiple] a B [ruiltiple] [multiple]
Diarneter T L | [rnuiltiple] [rauiltiple] 1] | [rnualtiple] [rauiltiple]
S [T L | [roultiple] [multiple] 3200 B [ruiltiple] [multiple]
by -200 | [roultiple] [multiple] 3200 B [rultiple] [multiple]
f il [merl |- Bl il .
Cloge

Figure 66 — Display statistics screen

You can use the Filters section to apply up to five filters to the data in this layer, for
example you may want to view the statistics for only those points in a .pst file that
correspond to the first line of meteorological data and/or have a receptor height of 2 m.
Whenever the filters are modified, it is necessary to click the Refresh button for the
changes to take effect.

Other useful features include:

e The Copy button can be used to copy the entire table to the clipboard, which can
then be pasted into a text editor (e.g. Notepad) or spreadsheet package (e.g.
Microsoft Excel).

« Similarly, the I buttons can be used to copy the statistics for a particular field to
the clipboard. If there are multiple X, Y locations where the minimum or
maximum occur for that field, the data for all locations will be copied, thus
expanding on the information shown in the table.

e The X, Y location(s) of the minimum or maximum can also be highlighted in the
map view window using the relevant binoculars icon A For example, this can
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be used to identify the location(s) of the lowest and highest concentrations in a
.glt file, as demonstrated in Figure 67.

5 ADMS Mapper e | | 0MS Mapper [E=SE=R =]
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Figure 67 — Displaying the minima (left) and maxima (right) of a .glt field
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A.1 Label formatting

This section? outlines how to format the display labels using some of the more advanced
features available in the Mapper.

Al1l Overview

The Mapper provides a simple markup language for custom label formatting. You can
apply this in the Label section of the layer properties dialog for the layer.

Vector: Point sources (1) @
+ e Visible
General Value it
Sections
B Section 1 ﬂ
Renderer
Marker b I r
Line
Area Font
Chart =
D Arial J |3 pt J ‘. 000000 J
I u d
I u

Label

|. FFFFO0 J ‘ J
| 2500 tnips | |2500 twips | iex =]

Cutline

& H | I — |1 1 | -

Wizard ... oK | Cancel | Apply |

Figure 68 - Layer label properties

You can use the Value to both define and format the label using format descriptors
described in the rest of this section. The label can be any combination of fixed text and
fields defined in the current layer. A simple example would be to have the fixed text
“Canyon” and then use the CanyonHeight field to display the canyon height for all
roads using the specified formatting.

2 This information is taken from the following site:
http://docs.tatukgis.com/EDT/ENU/Help/index.htm?mnulayerpropertiesvectorlabelformatting.htm

ADMS Mapper User Guide Page 91


http://docs.tatukgis.com/EDT/ENU/Help/index.htm?mnulayerpropertiesvectorlabelformatting.htm

APPENDIX A —Advanced topics
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Figure 69 - Setting the label value option
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Figure 70 - Map with formatted labels
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A.l.2

Visual formatting

The Value input supports some of the standard HTML markers for visual formatting:

Markup Description

<B></B> Text inside is displayed in bold

<I></I> Text inside is displayed in italic

<U></U> Text inside is underlined

<HR> Horizontal line

<BR> Line break

<P></P> Text inside is treated as a complete paragraph
<STRONG></STRONG>

Text inside is displayed in extra bold font

<FONT SIZE="S"
NAME="F"
COLOR="C"></FONT>

Text inside is displayed in the F font of the size S and colour C

F: ARIAL, TIMES, TAHOMA, etc.

C: BLACK, BLUE, FUCHSIA, GRAY, GREEEN, LIME, MAROON,
NAVY, OLIVE, PURPLE, RED, SILVER, TEAL, WHITE, YELLOW
The C colour can be also given in the RGB representation #RRGGBB,
where RR, GG and BB are two digit hexadecimal number
representations of the red, green and blue colour intensities

&amp; The ampersand (&) sign
&nbsp; Forced insertion of space
&gt; The greater-than (>) sign
&lt; The less-than (<) sign
Table 5 - Simple markup
Example

<U><FONT NAME="ARIAL" COLOR=#FF0000><I>valuel</I></FONT>&nbsp;<FONT
NAME="ARIAL" COLOR=#0000FF><B>&1t;</B></FONT>&nbsp;<FONT NAME="ARIAL"
COLOR=#00FF00><BOL>value2</BOL></FONT></U>

The above code will result in the following label: valuel <

A.l13

Inserting fields
The code {FIELD_NAME:FORMAT} inserts

the wvalue of a field or attribute

named FIELD_NAME with formatting defined by the format string FORMAT. The format
string is attribute type specific.

ADMS Mapper User Guide

Page 93




APPENDIX A —Advanced topics

Al4

Automatic formatting

Formatting of NUMBER and FLOAT type attributes

Format Format .
Description

character | name

Corec Currency Integer following the character defines the number of digits
displayed after the decimal point (default is 2).

Uses the currency marker from the system settings.
Dord Digit Integer next to the character defines the minimum number of digits
(integer) to be displayed; number will be padded with zeroes if necessary;
non-integer value will be rounded first.

E or e Scientific Integer next to the character defines the number of digits displayed

(exponential) | after the decimal point (default is 2); number formatted
as Scientific is always displayed in exponential form;

Forft Fixed-point Integer next to the character defines the number of digits displayed
after the decimal point (default is 2).

G or g General Displays the number in a format best suited for the value; Integer
next to the character defines the number of significant digits.

N or n Number Integer following the character defines the number of digits
displayed after the decimal point (default is 2); inserts thousand
separators accordingly to the system settings.

P orp Percent The number is multiplied by 100; Integer following the character
defines the number of digits displayed after the decimal point
(default is 2)

Rorr Round-trip Equivalent of General; Integer next to the character is ignored.

X or x Hexadecimal | Integer next to the character defines the minimum number of

hexadecimal digits to be displayed; number will be padded with
zeroes if necessary; non-integer values will be rounded first.

Custom formatting:

Table 6 - Automatic number formatting

Format | Name Description

character

i Digit Defines optional position of a digit; if corresponding digit in the
placeholder value does not exist, the digit placeholder is neglected.

0 Zero Defines obligatory position of a digit; if corresponding digit in the
placeholder value does not exist, the zero placeholder is replaced by '0".
Decimal Defines the position of the decimal point.
point

[other]

Other characters are displayed without any change.

Table 7 - Custom number formatting
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Examples:

Code Attribute | Result Note
value string

{FIELD NAME:#.###) 123.59 '123.59'

{FIELD NAME:#.000} 123.59 '123.590'

{FIELD NAME:#.####0} 123.59 '123.59000'

{FIELD NAME:#####.##4#) -123.59 '-123.59'

{FIELD NAME:00000.###} 123.59 '00123.59'

{FIELD_NAME:0-0-0-0-0} 123.59 '0-0-1-2-4' | rounding

{FIELD_NAME:over #;below #;zero #} | 12359 '‘over 124" rounding

{FIELD NAME:over #;below #;zero #} | _.123.59 'below 124" | rounding, no minus

sign

{FIELD NAME:over #;below #;zero #} | 'zero ' no zero sign

{FIELD NAME:over #;below #;zero 0} | ‘zero 0'

{FIELD NAME:;below #;zero#} 123.59 " empty string

{FIELD NAME:over #;;zero#} -123.59 " empty string

{FIELD NAME:over #;below #;} 0 " empty string

A.l15

Table 8 - Number formatting examples

Automatic formatting:

Formatting of BOOLEAN type attributes

Code Attribute value Result
{FIELD NAME} True True'
{FIELD_NAME} False 'False’

Table 9 - Automatic Boolean formatting

Examples:

Code Attribute value Result Note
{FIELD NAME:yes;no} True ‘yes'

{FIELD NAME:yes;no} False no’

{FIELD NAME:yes} True ‘yes'

{FIELD NAME:yes} False " empty string
{FIELD NAME:;no} True " empty string
{FIELD NAME:yes; } False " empty string
{FIELD NAME:yes;nol;no2} False 'nol;no2'

Table 10 - Boolean formatting examples
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A.1.6

Formatting of DATE type attributes

Note: character in brackets represents a string consisting of any number of this character.

Format Format name Description

string

d Day Day as a number 1 to 31

dd Day Day as a number 01 to 31

ddd Day Day as an abbreviated name of the day of the week; depends
on system regional settings

dddd (d) Day Day as a full name of the day of the week; depends on
system regional settings

£ Second fraction Most significant digit of the second fraction

£f Second fraction Two most significant digits of the second fraction

fff Second fraction Three most significant digits of the second fraction

ffff Second fraction Four most significant digits of the second fraction

fffff Second fraction Five most significant digits of the second fraction

fEffff Second fraction Six most significant digits of the second fraction

fEEEELL () | Second fraction Seven most significant digits of the second fraction

F Second fraction Most significant digit of the second fraction; if zero then
nothing will be displayed

FF Second fraction Two most significant digits of the second fraction; trailing
zeros will be truncated

FFF Second fraction Three most significant digits of the second fraction; trailing
zeros will be truncated

FFFF Second fraction Four most significant digits of the second fraction; trailing
zeros will be truncated

FFEFF Second fraction Five most significant digits of the second fraction; trailing
zeros will be truncated

FFFFFE Second fraction Six most significant digits of the second fraction; trailing
zeros will be truncated

FFEFFF (F) | Second fraction Seven most significant digits of the second fraction; trailing
zeros will be truncated

h Hour Hour as a number 1 to 12

hh (h) Hour Hour as a number 01 to 12

H Hour Hour as a number 1 to 24

HH (H) Hour Hour as a number 01 to 24

m Minute Minute as a number 0 to 59

mm (m) Minute Minute as a number 00 to 59

M Month Month as a number 1 to 12

MM Month Month as a number 01 to 12

MMM Month Month as an abbreviated name of the month; depends on

system regional settings
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MMMM (M) Month Month as a full name of the month; depends on system
regional settings

S Seconds Seconds as a number 0 to 59

ss(s) Seconds Seconds as a number 00 to 59

t AM/PM First character of the '"AM' or 'PM' string; depends on system
regional settings

te(t) AM/PM 'AM' or 'PM' string; depends on system regional settings

Y Year Year as a two digit number; if year has less than two digits
then one digit number will be displayed

Yy Year Year as a two digit number; if year has less than two digits
then result will be padded with zero

yyy Year Year as a three digit number; if year has less than three digits
then result will be padded with zeros

Yyyy Year Year as a four digit number; if year has less than four digits

then result will be padded with zeros

yyyy (y) Year Year as a five digit number; if year has less than five digits
then result will be padded with zeros

[other] Other characters are displayed without any change

Table 11 - Custom date formatting
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Examples:

Code Attribute value Result
{FIELD NAME:d} 3rd of June 2008: 17:09:03.650, US English 3"
{FIELD_NAME:dd) 3rd of June 2008: 17:09:03.650, US English | '03'
{(FIELD_NAME:ddd) 3rd of June 2008: 17:09:03.650, US English | "Tue'
{FIELD_NAME:dddd} 3rd of June 2008: 17:09:03.650, US English ‘Tuesday'
{FIELD_NAME:M} 3rd of June 2008: 17:09:03.650, US English '6'
{FIELD_ NAME:MM} 3rd of June 2008: 17:09:03.650, US English '06'
{FIELD_NAME:MMM} 3rd of June 2008: 17:09:03.650, US English "Jun'
{FIELD_ NAME :MMMM} 3rd of June 2008: 17:09:03.650, US English "June’
{FIELD NAME:y} 3rd of June 2008: 17:09:03.650, US English '08'
{FIELD NAME:yy} 3rd of June 2008: 17:09:03.650, US English '08'
{FIELD_NAME:yyy} 3rd of June 2008: 17:09:03.650, US English '008'
{FIELD NAME:yyyy} 3rd of June 2008: 17:09:03.650, US English '2008'
{FIELD NAME:yyyyy} 3rd of June 2008: 17:09:03.650, US English '02008'
{FIELD NAME:h} 3rd of June 2008: 17:09:03.650, US English 5"
{FIELD NAME:hh} 3rd of June 2008: 17:09:03.650, US English '05'
{FIELD_NAME:H} 3rd of June 2008: 17:09:03.650, US English | '17'
{FIELD_NAME:HH} 3rd of June 2008: 17:09:03.650, US English | '17'
{FIELD NAME:t} 3rd of June 2008: 17:09:03.650, US English P
{FIELD NAME:tt} 3rd of June 2008: 17:09:03.650, US English PM'
{FIELD_NAME:m} 3rd of June 2008: 17:09:03.650, US English | '9’
{FIELD_ NAME :mm} 3rd of June 2008: 17:09:03.650, US English '09'
{FIELD NAME:s} 3rd of June 2008: 17:09:03.650, US English 3"
{FIELD_NAME:ss} 3rd of June 2008: 17:09:03.650, US English | '03'
{FIELD_NAME:f} 3rd of June 2008: 17:09:03.650, US English | '6'
{FIELD NAME:ffff} 3rd of June 2008: 17:09:03.650, US English '6500'
{FIELD NAME:FFFF} 3rd of June 2008: 17:09:03.650, US English '65'
{FIELD NAME:yyyy/MM/dd | 3rd of June 2008: 17:09:03.650, US English | '2008/06/03

HH/mm/ss.ffff}

17:09:03.6500'

Table 12 - Date formatting examples
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A.1.7 Formatting of STRING type attributes
Note: i is a placeholder for an integer number.

Format Name Description
character
S normal text | Text displayed without any changes.
S uppercase | Text displayed in uppercase.
S lowercase | Text displayed in lowercase.
i fat the first i>0 defines from which character (counting from the beginning
beginning] character | of the string) should be the string displayed,; if i<0 then the
characters are counted from the end of the string.
i [at the last i>0 defines up to which character (counting from the beginning
end] character of the string) should be the string displayed; if i<0 then the
characters are counted from the end of the string.
H force force HTML interpretation of <> symbols
HTML

Table 13 - Custom string formatting

Examples:

Code Attribute value Result string Note
{FIELD NAME:S$} 'Abcdefghij’ '‘Abcdefghij'

{FIELD NAME:S} 'Abcdefghij’ 'ABCDEFGHIJ'

{FIELD NAME:s} 'Abcdefghij' ‘abcdefghij’
{FIELD_NAME:13-1} 'Abcdefghij’ 'Abcdefghij'
{FIELD_NAME:1S3} 'Abcdefghij' 'ABC'

{FIELD_NAME:1s3} 'Abcdefghij’ ‘abc'

{FIELD_NAME:1$-3} 'Abcdefghij’ 'Abcdefgh’
{FIELD_NAME:-3%-1} 'Abcdefghij’ ‘hij*

{FIELD_NAME:4$-4} 'Abcdefghij' 'defg’

{FIELD_NAME:8%-8} 'Abcdefghij' " empty string
{FIELD_NAME:H} 'A<b>c' '‘A&lt;b;&gt;c’
{FIELD_NAME:H$} 'A<b>c' '‘A&lt;b;&gt;c’
{FIELD_NAME:HS} '‘A<b>c’ 'A&It;B;&gt;C'
{FIELD_NAME:Hs} 'A<b>C' 'a&lt;b; &gt;c’
{FIELD_NAME:H1s3} 'A<b>C' ‘a&lt;b’

Table 14 - String formatting examples
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A.2 Using symbology files

The Mapper supports symbology (SYM) files, which use a series of command instructions to
create custom line styles. When drawing the layer using a symbology file, the Mapper will
follow the rendering instructions to draw custom lines. The “mini-language” used to code the
instructions is set out in Table 15.

A.2.1 Transparent roads example

There are times when you wish to see the concentration contours but when the source
is displayed the contours are obscured. This can be the case for Road sources where the
highest concentrations are along the road. Hiding the road layer (unticking it in the
layer panel) is a possibility, but then you lose the visual information about the road
layout. On solution would be to display road sources with the contour plot showing
through — i.e. delineated by their borders alone so that the main body of the polyline
would be transparent.

The following example demonstrates how a symbology file can be applied to the Road
sources layer in order to produce the transparency effect described above.

Step 1 Double click on the layer of interest in the layer panel to bring up the layer
properties window — in this case bring up the properties for the Road
sources layer as shown in Figure 71.

Vector: Road sources (8) @
o b Visible
General Line
Sections
S Section 1 Style Color Pattern
| <] Mo ] [ooe 1]
Marker .
Area Width
Label | 1000 m * ﬂ |II- pt J |E deg J
Chart
3D Smart size
M Section 2 12 twips -
Qutline
Style Color Pattern
| <] (Moo <] [ ]
Width
1 twips hd
v Indude in legend
=
Wizard ... 0K | Cancel ‘ Apply

Figure 71 - Layer properties window

Step 2 Choose Line from the left panel, and in the Line section, use the drop-down
menu under Style to choose the Symbol... button in order to bring up the
Symbol dialog, see Figure 72.
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[ Symbol ==

File ...
Font ...

Library ... Mone

il

Cancel

Figure 72 - Symbol dialog

Step 3  Click the File button in the Symbol dialog and browse for the example .sym
file supplied with the installation, Figure 73. A sample rendering should
be displayed in the Symbol dialog, Figure 74.

Open =55
Look: in: | | Data j L] £ B~
L= Name = Date modified Type
Py
Hec;;ﬁaces [ TBaiyine border and dotted centeline.sym . 30/01/3014 16447 SYM Eile
Desktop
w=all
Libraries
LY
Computer
= )
W
Metwork
] 1 3
File name: |Poh'line border and dotted centeline sym j Open |
Files of type: | All Supported Files | Cancel

Figure 73 - Selecting a symbology file
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File Symbol

-

Font.. | Fle.. |

Cancel

Reset |

Figure 74 - Symbol dialog showing example symbology

Step 4 Click OK to return to the Layer properties window (Figure 75) and either
click Apply or OK to apply the chosen symbology to the Road sources layer,

Figure 76.
Wector: Road sources (8)
=
General
Sections
B Section 1
Renderer
Marker
Line
Area
Label
Chart
3D
B Section 2

= H

Wizard ...

Visible
Line
Style Calor
——— NN R E
Width Symbol Gap Symbol Rotate
|1DDIJmz j |Dpt j |Ddeg j
Smart size
12 twips -
Qutline
Color
| | [ o o] | E
1 twips
[v Indude in legend
oK | Cancel | Apply

EXH

Figure 75 - Layer properties window with symbology selected
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5 ADMS Mapper E=5(EsE 5
File Edit Help
ZPTTLIBTIVTBRA(GD e+ [@ad| --cahmeoc | &L wd-

Lapers Grouping ki)

21 [w] Point sources (1) ﬂ
L]
B [w] Line saurces [0]

B [w] Road sowrces (81

AN

B[ Area sources [0)

9]

A

]
9]

Wolume sources (0]

A

m
9]

Grid source cells [0

2

m
K

Output grid extent

AN

B[ Dutput points [361)
* =
A0MSUrban Wigw 200 m
Click ta zoom in |><' 5.4452343E +05 v 2 596579E+05 |Edilmg‘ none Scale: 1:8,600 Y

Figure 76 - Roads layer with symbology applied.

Step 5 Load a contour layer to see the effects of the new rendering, Figure 77 and
Figure 78.

15 ADMS Mapper EI
Eile Edit Help
Z/ 9T R (BLIMRAQIGO ¢ » (@A - -cumuS |
Layers Grouping 3D
= A

B[] Road sources [8]

B[+ Area sources (0]

Xl

EN

A [v] Yalume sources (0]

]

A

Kl

B[ Grid source cells [0)

2

B[] Output grid extent

Xl

AN

B [w] Output points [361]
+
B[] MO ugém3 contours

P
+ ¢
NG ug/m3 Ei P
Lo
e
ADMSLiban View 200 m

X 54B27I22E 05 ¥: 25971115605 |Edifing: none | Scale: 18500,

Figure 77 - Roads layer with symbology applied over a contour layer.
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) ADMS Mapper [E=8 BN =)

Eile Edit Help
E R AR R AR BTN R T Gas|- - & lmd-

Layers Grouping 30

5

B[] Road sources [8)

B[ Ares sources (0]

&K

AENEN

B[ Volume sources (0]

&

A

B | Grid source cells (0]

X

2

Bl [ Output grid extent

B[] Output peints [961]
+
B[] MOk ug/m3 contours

Niix ug/md -

100 m

Click to redo the previous edit i£: 5.4485019E+05 . 2.5928955E+05 | Editing: none Seale: 1:3,750

Figure 78 - Close up of Roads layer with symbology applied over a contour layer.

A.2.2 Making symbology files
The following list summarises the key elements of using symbology files

e All parameters (except GOTO) are relative and move the “drawing position”
cursor along the shape.

e The X coordinate moves cursor along the shape. The Y coordinate moves
cursor perpendicularly.

e Drawing can contain as many commands as desired.
e Using GOTO(0) enables drawing over an already drawn line.
e FOR..END loop cannot be embedded into another loop.

e The more complicated the symbol, the slower the drawing speed.
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Commands
Full Short | Description Sample
; Comment out whole line ;A comment
GOTO (x) G Move drawing position along the shape to an | GOTO (10%)
arbitrary position. G(10%)
MOVE (dx, dy) M Move drawing along line by a delta. MOVE (10, -10)
M(+10-10)
DRAW(x1,yl,x2,y | D Draw a vector segment. DRAW(S,5 5 =5)
2, ..,X0n,yn) D (+5+5+5-5)
OUTLINE (x1,yl,x | O Draw a line symbol with the rotation point at | OUTLINE (5,5 -
2ry2y .., xXn,yn) the place of the current “drawing position”. éO’_So ? ,=1010,0
Whole symbol will be rotated with the same | J (+5+5-1040+0—
parameters. _ 10+10+0+0-10)
First set of coordinates means the starting
point of the shape.
FILL(x1l,yl,x2,y |1 Draw a filled symbol with the rotation point | FILL (5,5 -10,0
2 s X0 yn) at the place of the current “drawing position”. [1)6)_1 0 10,0 0,-
Whole symbol will be rotated with the same | © (4545-1040+0—
parameters. _ 10+10+0+0-10)
First set of coordinates means the starting
point of the shape.
FOR (x) F Start of the loop. Parameters for the distance | FOR (50%)
the loop will be repeated. Default is 100%. A | F(50%)
negative value means calculation starting
from the end of the line. For example, FOR(-
45%) means repeat until 45% of the distance
of the entire line length, starting from the end
of the line.
END (} E End of the loop. END ()
E(Q)
W (10W)
C(255,0,0)
COLOR (mode) ¢ Change drawing color to: COLOR (1)
0 - line/area color ¢
1 - outline color
Table 15 - Symbology commands summary
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Values option

Option | Description Sample
None Default — pixels GOTO (10)
X Device independent pixels - 1 pixel in 96dpi. Multiplied by 10 so 10X GOTO (10X)
means one "pixel"
Twips (1/1440 of inch) GOTO (700T)
W Line width (as set for Line.Width) expressed multiplied by 10. So 15T GOTO (15T)
means 1.5 line widths.
S Line with scaled device independent pixels (similar to 'X'). Scales means | GOTO (105)
that wider lines will result no proportional scaling: 10X for thin lines
means really same as 10X but for wider line it will be represented by
smaller value for better visual effect
Table 16 - Symbology measuring settings
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A.3 Recognised file types

The Mapper supports loading the following recognised file types and formats natively. This
allows them to be displayed in the map view as new non-editable layers. The list is not
comprehensive, but gives the most commonly supported file types.

Format

ArcExplorer Project File

Arcinfo Ascii Grid

Arcinfo Binary Grid

Arcinfo Export Format

Arcinfo Float Grid

ArcView 3.xx Project File

ArcView Shape Files

AutoCAD DWG

AutoCAD DXF

Binary Terrian Grid

CADRG Compressed ARC Digitized Raster Graphics
Census 2000 TIGER/Line

Comma Separated Values point layer (CSV)
Digital Elevation Model (ASCII GRID or SPOT)
Digital Line Graphs (DLG)

Digital Terrain Elevation Data

Enhanced Compressed Wavelet

ERDAS IMAGINE Image File Format
ESRI File Geodatabase API for vectors
FME Feature Store

File extension
*.aep

*.asc

*.adf

*.e00

* flt

*.apr

*.shp

*.dwg

*.dxf

* bt

* toc

*rtl

*.csv and others
*.dem
*.opt;*.dlg
*.dt0;*.dt1;*.dt2
*.ecw

*.img

* ttkls; *.ttklayer
* ffs

GDAL Wrapper for raster formats (multiple)
Geographic Data Files *.gdf
Geographic Markup Language *.gml;*.xml
GeoJSON * json;*.geojson
Global Self-consistent Hierarchical High-res Shorelines GSHHS ~ *.rim;*.b
Golden Software Surfer Grid *.grd
Google Earth Keyhole Markup Language * kml;*.kmz
GPS Exchange Format *.gpx
Graphic Interchange Format * gif
IHO S-57 ENC *.000
JPEG 2000 via ECW *jp2
JPEG 2000 via MRSID *jp2
JPEG File Interchange Format *.Jpg;*.jpeg
LandXML *xml
LiDAR LAS (ASPRYS) * las
Lizardtech MrSID *.sid
Maplnfo Interchange Format *.mif
MapInfo Native Format * tab
MapInfo WorkFile *.wor
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MaplInfoX Project File
MicroStation Native Format
OGR Wrapper for vector formats
Open Asset Import Library
OpenStreetMap Format
Pictometry Oblique Images

PLY Polygon File Format
Portable Network Graphic
Protocol Layer Connector

QGIS Project File

SAGA GIS Binary Grid

SDTS Raster Profile and Extensions
SDTS Topological Vector Profile
SPOT Binary In-line Format
SQL Layer Connector

SRTM HGT Grid

Standard Tessallation Language
Tag Image File Format
TatukGIS PixelStore

TatukGIS Project File

Vector Product Format (VPF)
Window Bitmap

XYZ Point Cloud data

*.gst

*.dgn

(multiple)
(multiple)
*.mvt;*.pbf;*.osm
*.psi

*.ply

*.png

* ttkwp; *.ttklayer
*.q9s;*.q9z

* sdat

*.ddf

*.ddf

* bil;*.dem

* ttkls;*.ttklayer
*.hgt

* stl;*.stla

* tif; > tiff

* ttkps;*.ttklayer
* ttkproject;*.ttkgp
*.dht; *.Iht

*.bmp

*.Xyz; *.asc
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